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Safety Instructions
Safety Instructions • English

 WARNING:	 This symbol,  ,when used on the product, is 
intended to alert the user of the presence of uninsulated dangerous 
voltage within the product’s enclosure that may present a risk of electric 
shock.

ATTENTION:	 This symbol, , when used on the product, is intended 
to alert the user of important operating and maintenance (servicing) 
instructions in the literature provided with the equipment.

For information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and 
Regulatory Compliance Guide, part number 68-290-01, on the Extron 
website, www.extron.com.

Sicherheitsanweisungen • Deutsch

WARNUNG:	 Dieses Symbol  auf dem Produkt soll den Benutzer 
darauf aufmerksam machen, dass im Inneren des Gehäuses dieses 
Produktes gefährliche Spannungen herrschen, die nicht isoliert sind und 
die einen elektrischen Schlag verursachen können.

VORSICHT:  Dieses Symbol  auf dem Produkt soll dem Benutzer in 
der im Lieferumfang enthaltenen Dokumentation besonders wichtige 
Hinweise zur Bedienung und Wartung (Instandhaltung) geben.

Weitere Informationen über die Sicherheitsrichtlinien, Produkthandhabung,  
EMI/EMF-Kompatibilität, Zugänglichkeit und verwandte Themen finden Sie in 
den Extron-Richtlinien für Sicherheit und Handhabung  (Artikelnummer  
68-290-01) auf der Extron-Website, www.extron.com.

Instrucciones de seguridad • Español

ADVERTENCIA:	 Este símbolo, , cuando se utiliza en el producto, 
avisa al usuario de la presencia de voltaje peligroso sin aislar dentro del 
producto, lo que puede representar un riesgo de descarga eléctrica.

ATENCIÓN:	 Este símbolo, , cuando se utiliza en el producto, avisa 
al usuario de la presencia de importantes instrucciones de uso y 
mantenimiento recogidas en la documentación proporcionada con el 
equipo.

Para obtener información sobre directrices de seguridad, cumplimiento 
de normativas,  compatibilidad electromagnética, accesibilidad y temas 
relacionados, consulte la  Guía de cumplimiento de normativas y seguridad 
de Extron, referencia 68-290-01, en el sitio Web de Extron, www.extron.com.

Instructions de sécurité • Français

AVERTISSEMENT :	 Ce pictogramme, , lorsqu’il est utilisé sur le 
produit, signale à l’utilisateur la présence à l’intérieur du boîtier du 
produit d’une tension électrique dangereuse susceptible de provoquer 
un choc électrique.

ATTENTION :	 Ce pictogramme, , lorsqu’il est utilisé sur le produit, 
signale à l’utilisateur des instructions d’utilisation ou de maintenance 
importantes qui se trouvent dans la documentation fournie avec le 
matériel.

Pour en savoir plus sur les règles de sécurité, la conformité à la 
réglementation, la compatibilité EMI/EMF, l’accessibilité, et autres sujets 
connexes, lisez les informations de sécurité et de conformité Extron, réf. 
68‑290-01, sur le site Extron, www.extron.com.

Istruzioni di sicurezza • Italiano 

AVVERTENZA:	 Il simbolo, , se usato sul prodotto, serve ad 
avvertire l’utente della presenza di tensione non isolata pericolosa 
all’interno del contenitore del prodotto che può costituire un rischio di 
scosse elettriche.

ATTENTZIONE:	 Il simbolo, , se usato sul prodotto, serve ad 
avvertire l’utente della presenza di importanti istruzioni di funzionamento 
e manutenzione nella documentazione fornita con l’apparecchio.

Per informazioni su parametri di sicurezza, conformità alle normative, 
compatibilità EMI/EMF, accessibilità e argomenti simili, fare riferimento 
alla Guida alla conformità normativa e di sicurezza di Extron, cod. articolo 
68‑290‑01, sul sito web di Extron, www.extron.com.

Instrukcje bezpieczeństwa • Polska  

OSTRZEŻENIE:	 Ten symbol, , gdy używany na produkt, ma na celu 
poinformować użytkownika o obecności izolowanego i niebezpiecznego 
napięcia wewnątrz obudowy produktu, który może stanowić zagrożenie 
porażenia prądem elektrycznym.

UWAGI:	 Ten symbol, , gdy używany na produkt, jest przeznaczony do 
ostrzegania użytkownika ważne operacyjne oraz instrukcje konserwacji 
(obsługi) w literaturze, wyposażone w sprzęt.

Informacji na temat wytycznych w sprawie bezpieczeństwa, regulacji 
wzajemnej zgodności, zgodność EMI/EMF, dostępności i Tematy pokrewne, 
zobacz Extron bezpieczeństwa i regulacyjnego zgodności przewodnik, część 
numer 68-290-01, na stronie internetowej Extron, www.extron.com.

Инструкция по технике безопасности • Русский

ПРЕДУПРЕЖДЕНИЕ:	 Данный символ, , если указан 
на продукте, предупреждает пользователя о наличии 
неизолированного опасного напряжения внутри корпуса 
продукта, которое может привести к поражению 
электрическим током.

ВНИМАНИЕ: 	 Данный символ, , если указан на продукте, 
предупреждает пользователя о наличии важных инструкций 
по эксплуатации и обслуживанию в руководстве, 
прилагаемом к данному оборудованию.

Для получения информации о правилах техники безопасности, 
соблюдении нормативных требований, электромагнитной 
совместимости (ЭМП/ЭДС), возможности доступа и других 
вопросах см. руководство по безопасности и соблюдению 
нормативных требований Extron на сайте Extron: ,  
www.extron.com, номер по каталогу - 68-290-01.

安全说明 • 简体中文 

警告： 产品上的这个标志意在警告用户该产品机壳内有暴露的危险 电压，
有触电危险。

注意： 产品上的这个标志意在 提示用户设备随附的用户手册中有 
重要的操作和维护(维修）说明。

关于我们产品的安全指南、遵循的规范、EMI/EMF 的兼容性、无障碍 
使用的特性等相关内容，敬请访问 Extron 网站 , www.extron.com，参见 

Extron 安全规范指南，产品编号 68-290-01。



안전 지침 • 한국어 

경고: 	 이 기호  가 제품에 사용될 경우, 제품의 인클로저 내에 있는 
접지되지 않은 위험한 전류로 인해 사용자가 감전될 위험이 있음을 
경고합니다.

주의:	 이 기호  가 제품에 사용될 경우, 장비와 함께 제공된 책자에 나와 
있는 주요 운영 및 유지보수(정비) 지침을 경고합니다.

안전 가이드라인, 규제 준수, EMI/EMF 호환성, 접근성, 그리고 관련 항목에 
대한 자세한 내용은 Extron 웹 사이트(www.extron.com)의 Extron 안전 및 
규제 준수 안내서, 68-290-01 조항을 참조하십시오. 

安全記事 • 繁體中文 

警告: 若產品上使用此符號，是為了提醒使用者，產品機殼內存在著 
可能會導致觸電之風險的未絕緣危險電壓。

注意	  若產品上使用此符號，是為了提醒使用者，設備隨附的用戶手冊中有
重要的操作和維護（維修）説明。

有關安全性指導方針、法規遵守、EMI/EMF 相容性、存取範圍和相關主題的詳細資
訊，請瀏覽 Extron 網站：www.extron.com，然後參閱《Extron 安全性與法規
遵守手冊》，準則編號 68-290-01。

安全上のご注意 • 日本語 

警告:	この記号  が製品上に表示されている場合は、筐体内に絶縁されて 
いない高電圧が流れ、感電の危険があることを示しています。

注意:	この記号  が製品上に表示されている場合は、本機の取扱説明書に 
記載されている重要な操作と保守(整備)の指示についてユーザーの注意
を喚起するものです。

安全上のご注意、法規厳守、EMI/EMF適合性、その他の関連項目に  
ついては、エクストロンのウェブサイト www.extron.com より 『Extron Safety 
and Regulatory Compliance Guide』 (P/N 68-290-01) をご覧ください。
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FCC Class A Notice
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to part 15 of the FCC rules. The Class A limits provide reasonable 
protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio frequency energy and, 
if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications. Operation of this equipment in a residential area is 
likely to cause interference. This interference must be corrected at the expense of the user.

NOTE:	 For more information on safety guidelines, regulatory compliances, EMI/EMF 
compatibility, accessibility, and related topics, see the Extron Safety and Regulatory 
Compliance Guide on the Extron website.
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Conventions Used in this Guide

Notifications
In this user guide, the following are used:

ATTENTION:	 Attention indicates a situation that may damage or destroy the product 
or associated equipment.

NOTE:	 A note draws attention to important information.

TIP:	 A tip provides a suggestion to make setting up or working with the device easier.

Software Commands
Commands are written in the fonts shown here: 

^AR Merge Scene,,Op1 scene 1,1 ̂ B 51 ̂ W^C

[01] R 0004 00300 00400 00800 00600 [02] 35 [17] [03]

E X!*X1&*X2)*X2#*X2! CE}

NOTE:	 For commands and examples of computer or device responses mentioned 
in this guide, the character “0” is used for the number zero and “O” represents the 
capital letter “o”.

Computer responses and directory paths that do not have variables are written in the font 
shown here: 

Reply from 208.132.180.48: bytes=32 times=2ms TTL=32

C:\Program Files\Extron

Variables are written in slanted form as shown here:
ping xxx.xxx.xxx.xxx —t

SOH R Data STX Command ETB ETX

Selectable items, such as menu names, menu options, buttons, tabs, and field names are 
written in the font shown here:

From the File menu, select New.
Click the OK button.

Specifications Availability
Product specifications are available on the Extron website, www.extron.com.

Extron Glossary of Terms
A glossary of terms is available at www.extron.com/technology/glossary.aspx.
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Introduction

This section provides an overview of the user guide and describes the Extron  
VN-Matrix (VNM) Recorder and its features. Topics that are covered include:

•	 About this Guide

•	 About the VNM Recorder

•	 Transport Protocols Used for Streaming

•	 Definitions

•	 Features

About this Guide
This guide contains installation, configuration, and operating information for the  
VNM Recorder.

In this guide:

•	 The term "recorder" refers specifically to the VNM Recorder.

•	 The term "codec" refers to either a VN-Matrix encoder or decoder.

•	 The term "stream" refers to multimedia that is constantly received by (and normally 
presented to) an end-user while being delivered by a VN-Matrix encoding device.

•	 The term "element" refers to the video/graphics, audio, data, and whiteboard  
(user data) content that is contained within a stream.

About the VNM Recorder
The VNM Recorder connects to a network and is used to digitally record and play back 
multiple PURE3® streams via the IP network of VN-Matrix encoders and decoders. The  
VNM Recorder is used with any VN-Matrix application to document, archive, review, and  
play back highly sophisticated or demanding AV imagery.

The VNM Recorder has the ability to record PURE3 encoded IP streams on each channel. 
Up to five PURE3 streams can be recorded or played back on a single recorder. PURE3 
streams recorded together maintain proper synchronization on playback.

The VNM Recorder uses a network storage architecture which makes systems highly 
scalable and flexible. Storage capacity can be increased or decreased based on the number 
of inputs, recording time, and archiving requirements.
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Figure 1 shows a typical VNM Recorder application, which includes a single VN-Matrix 
codec. The application shown in figure 1 can operate in recording mode or playback mode.

Network
VN-MATRIX 300 SERIES

SERIAL DIGITAL VIDEO OVER IP

LAN-1
LAN-2
STATUS
ALARM

TEST

Control PC

TCP/RTP

TCP/RTP

Source

VN-Matrix Codec

VNM Recorder

Target
Display

Figure 1.	 VNM Recorder Application Diagram

Overview of Recorded Streams
The following information is associated with recorded streams when using the  
VNM Recorder.

•	 Recorded streams are stored as files on the VNM Recorder.

•	 Each recording contains (as a minimum) a video element.

•	 A recording may also include elements containing audio, data, and whiteboard 
information (if these are present and enabled at the encoder). If these are selected 
for storage, each element is stored as an individual file under the same directory.

•	 Each recording may contain up to five channels.

•	 Each channel originates from a VN-Matrix encoder device (or a VN-Matrix codec 
configured as an encoder).

Overview of Stream Playback
The following information is associated with stream playback when using the VNM Recorder.

•	 When a recording is selected for playback that contains multiple elements, the 
necessary files and channels (a maximum of five channels are supported) are loaded.

•	 The files that are loaded in each channel are treated as a single recording and may 
not be split.

•	 The video content, which is assigned to channel 1, is always played.

•	 The audio, data, and whiteboard elements may be enabled or disabled for playback 
(when present in the recording).

•	 During playback, the audio, whiteboard, and data elements are always 
synchronized to their respective video stream. In other words, all channels are 
synchronized to the video stream on channel 1.
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About RAID5 Storage
RAID storage is a system which allows hard drives to be linked together to form a single 
large capacity storage device that offers superior performance, storage capacity, and 
reliability over other storage solutions.

The VNM Recorder uses RAID5 storage. RAID5 storage provides the following advantages.

•	 Increased storage performance.

•	 Full data redundancy which allows for data backup in the event of a hard drive failure.

•	 A hard drive is set aside as a hot spare drive which is used to automatically rebuild the 
data of a failed drive and allow the system to recover.

Transport Protocols Used for Streaming
The source data from a VN-Matrix encoder can be distributed to multiple displays/decoders 
(one-to-many) or to a single display/decoder (point-to-point). A previously recorded stream 
can be distributed in the same way and may be thought of as an encoder in this context.

A stream may be transported from the source (encoder, recorded stream) to the display 
(decoder) using one of three methods:

•	 Multicast Real-time Transport Protocol (RTP)

•	 Unicast Real-time Transport Protocol (RTP)

•	 Unicast Transmission Control Protocol (TCP)

By default, the VNM Recorder provides a choice of unicast RTP or unicast TCP transport 
protocols. A multicast transport protocol may be configured if required.

NOTES:

•	 During playback of a recorded stream, the default transport protocol used is unicast 
RTP.

•	 When a stream is recording, the VNM Recorder may be considered as a display 
(decoder) device.
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Multicast RTP — An Overview
Multicast RTP allows a source to be displayed on multiple displays. This method uses RTP, 
which is a real-time variation of UDP (User Datagram Protocol).

SOURCE

DISPLAYS

RTP RTP

RTP

RTP

RTP

RTP

Encoder sends data using RTP
to a multicast group.

Multiple decoders can be
part of the multicast group.

Network
VN-MATRIX 225 SERIES

RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

VN-MATRIX 225 SERIES
RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

VN-MATRIX 225 SERIES
RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

VN-MATRIX 225 SERIES
RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

VN-MATRIX 225 SERIES
RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

Figure 2.	 Multicast RTP Streaming

The source encoder uses RTP to send data to a multicast group. The source does not need 
to know the IP address of the decoders that are using the source.

RTP provides very low latency which is important for video streaming. Unlike other 
protocols, RTP packets include a time stamp. If packets are received in the wrong 
order, they are sorted into the correct order for display or discarded if the time stamp is 
out-of-date.

However, because RTP is a connectionless protocol, data delivery is not guaranteed.  
When data packets are lost (for example, due to excessive network traffic), the  
VN-Matrix 200 / 225 / 300 / 325 devices carefully manage the data stream to minimize any 
image disruption. 
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Unicast RTP — An Overview
Similar to multicast RTP, this method uses a real-time variation of UDP protocol, called 
unicast RTP. This method can be used where the network infrastructure does not support 
multicast traffic. Typically, this protocol is used for point-to-point configuration (single source 
to single display), but can be configured to use up to a maximum of four displays.

NOTE:	 The encoder sends an individual stream to each decoder. This means that the 
total bandwidth of the VN-Matrix system increases as more decoders are added.

RTP 3

RTP 4

RTP     (1-4)

VN-MATRIX 225 SERIES
RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

VN-MATRIX 225 SERIES
RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

VN-MATRIX 225 SERIES
RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

VN-MATRIX 225 SERIES
RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

VN-MATRIX 225 SERIES
RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

Network

DISPLAYS

SOURCE

Encoder sends data using RTP
to up to 4 specified decoders.

RTP 1

RTP 2

Figure 3.	 Unicast RTP Streaming

RTP provides very low latency which is important for video streaming. Unlike other 
protocols, RTP packets include a time stamp. If packets are received in the wrong 
order, they are sorted into the correct order for display or discarded if the time stamp is 
out-of-date.

However, because RTP is a connectionless protocol, data delivery is not guaranteed.  
When data packets are lost (for example, due to excessive network traffic), the  
VN-Matrix 200 / 225 / 300 / 325 devices carefully manage the data stream to minimize any 
image disruption.
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Unicast TCP — An Overview
This method transports data using standard TCP and should only be used for single 
point‑to-point transfer of data.

TCP is a connection-based protocol and, therefore, data is guaranteed to be delivered. 
However, in the event of excessive network traffic, delivery may be delayed which will impact 
real-time performance.

VN-MATRIX 225 SERIES
RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

VN-MATRIX 225 SERIES
RGB/DVI OVER IP

LAN-1
LAN-2
STATUS

Network

SOURCE

DISPLAYS

Decoder makes a TCP
connection with a 
specified encoder.

Encoder

TCP TCP

Figure 4.	 Unicast TCP Streaming

The decoder defines which source to connect to. Other than defining an IP address and 
source type (if required), no special source encoder setup is required.
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Definitions
PURE3 — PURE3 is specifically designed for network transmission of real time media (such 
as video or graphics, audio, data, and whiteboard elements). It features both spatial and 
temporal image compression, which allows for efficient bandwidth usage.

•	 PURE3 streams always contain video or graphic elements.

•	 PURE3 streams may contain audio, data, and whiteboard elements that are associated 
with the video and graphic elements.

Streaming media (stream) — This term refers to multimedia that is constantly received 
by (and normally presented to) an end-user while being delivered by a streaming provider. 
Internet television is a commonly streamed medium. Streaming media (stream) in this guide 
refers to a PURE3 media stream that is produced by a VN-Matrix encoding device.

Device license — This term refers to the number of licensed features that are available on 
a device within a VN-Matrix system. All devices contain a default license that offers a default 
level of functionality (see Licensed Features panel on page 29).

NOTE:	 The VNM Recorder contains a default license that allows for five recorder 
channels and five player channels. It is currently not possible to change the license on 
the VNM Recorder.

Controller license — This term refers to the license that is supplied to the device 
designated as the system controller (see Controller Licensing on page 42).

Data — This refers to the transfer method of data between an encoder and a decoder. Data 
input is created at the encoder, placed into the PURE3 stream, and sent to the decoder. The 
data is received in the same form that it was transmitted. This method of data transfer is 
unidirectional and can only be sent from an encoder to a decoder.

Whiteboard (wb) data — Also known as annotation data, whiteboard data outputs text 
and simple pointer annotation onto local displays that are connected to VN-Matrix encoders 
or decoders. This type of data is bidirectional, which allows a decoder to send whiteboard 
data to an encoder.

Features
•	 Record, synchronize, and play back up to five visually lossless PURE3 encoded 

VN‑Matrix streams over IP. 

•	 Digitally record and play back video/graphics, audio, and data.

•	 Use the gcode Frame Translator Utility to convert existing VN-Matrix video recordings 
into individual still frames (see gcode Frame Translator Utility Instructions on 
page 71).

•	 Virtual switching of video, graphics, and audio over IP.

•	 Point to point and long distance distribution.

•	 Link multiple recorder units together for applications requiring recording for more than 
five streams.

•	 The VNM Recorder is a scalable and flexible system.
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Panels and Cabling

This section provides information on:

•	 Installation Overview

•	 Front Panel Features

•	 Rear Panel Features

Installation Overview
1.	 Turn off and disconnect the VNM Recorder and all existing devices.

2.	 Mount the recorder, if necessary, as described in the Mounting section on page 72.

3.	 Connect any necessary devices to the recorder (see Front Panel Features below and 
Rear Panel Features on page 10).

4.	 Reconnect and power on all devices.

Front Panel Features

NOTE:	 Some features listed in this user guide may not be available on some units. This 
will not affect the overall functionality of the VNM Recorder.

The front panel of the VNM Recorder is shown in figure 5.

A BC D

G

F

E

Figure 5.	 VNM Recorder Front Panel

A	 SCA / SATA drive panel D	 Status LEDs G	 3.5 inch floppy drive

B	 Power button E	 USB Ports

C	 Reset button F	 CD or DVD drive
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A	 SCA / SATA drive panel — This panel houses the RAID5 hard drives. One hard drive 
is referred to as a hot spare drive, which is a drive that is inactive until an active drive 
fails. When an active drive fails, the hot spare drive rebuilds the data of the failed drive 
so that the system can recover.

B	 Power button — This is the main power button, which is used to apply or turn off the 
main power. When the main power is turned off, standby power is actively supplied to 
the recorder.

ATTENTION:	 If the recorder requires service, disconnect the power supply from 
the recorder before proceeding. 

ATTENTION:	 Si l'entretient de l'enregistreur doit être fait, débranchez la source 
d'alimentation de celui-ci avant de procéder.

C	 Reset button — Use this button to reboot the recorder.

D	 Status LEDs — Six LEDs are used to provide the status of the VNM Recorder (see  
figure 6).

1 2

Power

Overheat/Fan Failure Power Supply/Fan Failure

Drive Activity Network Activity (1) Network Activity (2)

Figure 6.	 Status LED Icons

•	 Power LED — This LED lights when the recorder is receiving power.

•	 Drive Activity LED — This LED indicates drive activity when flashing or flickering.

NOTE:	 This light may not respond and an audible alarm may go off if a 
hard drive has failed. Check to see if a hard drive has failed and replace if 
necessary.

•	 Network Activity LED (1) — This LED flashes to indicate activity on the first 
network.

•	 Network Activity LED (2) — This LED flashes to indicate activity on the second 
network.

•	 Overheat and Fan Failure LED — When this LED is flashing, it indicates that a 
fan has failed inside the recorder. When the LED is continuously lit, it indicates that 
the recorder has achieved a condition which may cause it to overheat. This LED will 
remain flashing or on for as long as these conditions exist.

NOTE:	 If the LED is continuously lit, the condition may be caused by cables 
obstructing the airflow of the recorder or the ambient room temperature. 
Check the routing of the cables and make sure all fans are operating normally. 
If necessary, move the recorder to a cooler location or adjust the room 
temperature.

•	 Power Supply/Fan Failure LED — When this LED is lit, it indicates a power 
supply fan has failed. The power supply module has a redundant backup fan that 
will increase its speed to compensate, but the power module should be replaced as 
soon as possible. The recorder may sound louder than usual during operation until 
the power supply is replaced.
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E	 USB (Universal Serial Bus) ports — Insert any compatible USB device into these 
ports. Use an external USB storage device with these ports to update the system.

F	 CD/DVD drive — Insert any compatible CD or DVD into this drive. This drive is used for 
system updates or software installation.

G	 3.5 inch floppy drive — This drive accepts 3.5 inch floppy disks.

Rear Panel Features

NOTE:	 Some features listed in this user guide may not be available on all units. This will 
not affect the overall functionality of the VNM Recorder.

The rear panel connections of the VNM Recorder are shown in figure 7.

A
B

C

D

E F

G H

I

J

K L

MN
OP

Q

R

S

Figure 7.	 VNM Recorder Rear Panel Connections

A	 Power input K	 Center/Subwoofer connector

B	 Alarm Reset button and LED L	 Line in connector

C	 PS/2 mouse connector M	 Rear speaker connector

D	 PS/2 keyboard connector N	 Front speaker connector

E	 USB connectors O	 Side speaker connector

F	 Parallel/Printer connector P	 Microphone connector

G	 COM1 serial connector Q	 VGA connector

H	 COM2 serial connector R	 7-pin connector

I	 Ethernet connector (eth0) S	 DVI connector

J	 Ethernet connector (eth1)
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A	 Power input (IEC connector) — Plug a standard IEC power cord into this connector 
to connect the recorder to a 100 to 240 VAC, 50 Hz or 60 Hz power source.

B	 Alarm Reset button and LED — When the recorder overheats or when a hard drive 
fails, an audible alarm is activated and the LED turns on to indicate that there is a 
problem with the device. Press this button to turn the alarm off.

C	 PS/2 mouse connector (optional) — Connect a PS/2 mouse to this port.

D	 PS/2 keyboard connector (optional) — Connect a PS/2 keyboard to this port.

E	 USB (Universal Serial Bus) connectors — Insert any compatible USB device into 
these ports.

F	 Parallel/Printer connector (not used)

G	 COM1 serial connector (not required) — Connect a compatible device to this 9-pin 
serial port.

H	 COM2 serial connector (not required) — Connect a compatible device to this 9-pin 
serial port.

I	 Ethernet connector (eth0) — Connect a RJ-45 cable to this port. This port connects 
to a primary network and is the default network port that should be used to connect to 
a VN-Matrix network. 

J	 Ethernet connector (eth1) — Connect a RJ-45 cable to this port. This port connects 
to a secondary network.

K	 Center/Subwoofer connector (not required; orange) — Connect a compatible 
center speaker or subwoofer to this port.

L	 Line in connector (not required; blue) — Connect a compatible line in device to 
this 3.5 mm port. Use this port to play external audio through the sound card of the 
recorder.

M	 Rear speaker connector (not required; black) — Connect a compatible rear 
speaker to this 3.5 mm port.

N	 Front speaker connector (not required; lime) — Connect a compatible front 
speaker to this 3.5 mm port.

O	 Side speaker connector (not required; gray) — Connect a compatible side speaker 
to this 3.5 mm port.

P	 Microphone connector (not required; pink) — Connect a compatible microphone to 
this port.

Q	 VGA connector — Connect a compatible VGA monitor to this port.

R	 7-pin connector (not active/used)

S	 DVI connector — Connect a compatible DVI monitor to this port.
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Recorder 
Configuration and 
Hardware Setup

This section provides information on how to configure the VNM Recorder so that it will  
work within a VN-Matrix system. After completing this chapter, see About the  
Web-based User Interface on page 23 for information about controlling the  
VNM Recorder using a control PC.

Topics that are covered include:

•	 Setup Overview

•	 VNM Recorder Power Up Procedure

•	 VNM Recorder Power Down Procedure

•	 Choosing the Controller Device

•	 Configuring the VNM Recorder

•	 Configuring the VN-Matrix Encoders and Decoders

Setup Overview
1.	 Connect a mouse, a keyboard, and a computer monitor (for configuration purposes) to 

the VNM Recorder (see Rear Panel Features on page 10).

2.	 Use a network switch to connect a primary VN-Matrix network to the rear panel 
Ethernet connector (eth0) of the VNM Recorder (see Rear Panel Features).

3.	 Power on the VNM Recorder and all necessary devices (see VNM Recorder Power 
Up Procedure on page 13).

4.	 Determine the device that will function as the controller (see Choosing the Controller 
Device on page 16).

5.	 Configure the VNM Recorder network settings (see Configuring the  
VNM Recorder on page 17).

6.	 Configure the network settings of each VN-Matrix encoder and decoder (see 
Configuring the VN-Matrix Encoders and Decoders on page 22).

7.	 Power down the VNM Recorder (see VNM Recorder Power Down Procedure on 
page 15) and all configured devices. After a few seconds, power on the  
VNM Recorder and all necessary devices.
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VNM Recorder Power Up Procedure
Use the following procedure to power up the VNM Recorder.

NOTE:	 Before turning on the VNM Recorder, ensure that all necessary devices are 
powered on and connected properly.

1.	 Press the power button on the front of the unit to initialize the bootup sequence.

2.	 After bootup is complete, the following login screen appears if a local monitor is 
connected. The VNM Recorder is now operational.

Figure 8.	 VNM Recorder Login Screen
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Login Information

NOTES:

•	 A mouse, keyboard, and monitor must be connected to the VNM Recorder to log in 
to the unit itself.

•	 Login information is case sensitive.

•	 It is only necessary to log in to the VNM Recorder when it requires configuration. 
The VNM Recorder does not require login information for normal operation.

Log in to the VNM Recorder using the Red Hat® Enterprise Linux® login page (see figure 8 
on the previous page). The default login information is as follows.

•	 Administrator username — root

•	 Administrator password — Extron2010

•	 Guest username — matrix_rec

•	 Guest password — matrix

If necessary, the administrator password, guest username, and guest password can 
be changed. New usernames can also be added.

NOTE:	 The procedures detailed within this guide use the administrator username 
and password to configure the recorder. It is recommended that the administrator 
username and password are only given to those who require it. Others should be 
using the guest login information (or a created personal login) to access the recorder 
so that important configuration settings cannot be changed.

To change the administrator password:

1.	 From the menu bar on the desktop, select System > Administration > 
Root Password.

2.	 If prompted for an administrator password, type in the appropriate password. The 
default administrator password is listed above.

3.	 Follow the remaining prompts to change the password.

To add or change usernames and passwords:

1.	 From the menu bar on the desktop, select System > Administration >  
Users and Groups.

2.	 The User Manager window appears. Use this window to add, modify, or delete users. 
Click on the Help menu for more information.
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VNM Recorder Power Down Procedure
Use the following methods to safely power down the VNM Recorder.

Using the Front Panel

If the VNM Recorder is not logged into:

1.	 Press and release the front panel power button.

2.	 The recorder takes approximately 20 to 30 seconds to power-down.

If the VNM Recorder is logged into:

1.	 Press and hold the power button until the LED of the power button turns off. This turns 
the recorder off instantly.

- OR -

1.	 Press and release the front panel power button.

2.	 The recorder opens a prompt asking for a shut down confirmation. There are three 
options to choose from.

•	 Log out

•	 Shut down

•	 Restart the computer

If desired, click on the Save current setup check box to save the desktop 
configuration. Select the appropriate radio button and click OK (see figure 9). The 
recorder takes approximately 20 to 30 seconds to shut down.

Figure 9.	 Front Panel Shut Down Confirmation Window
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Using the Keyboard and Mouse
From the login screen:

1.	 Click on either Shut Down or Restart as required.

2.	 The recorder opens a prompt asking for confirmation of the selected request.

3.	 The recorder takes approximately 20 to 30 seconds to complete the request.

From the Linux desktop:

1.	 From the menu bar on the desktop, select System > Shut Down...

2.	 The recorder opens a prompt containing four options.

•	 Hibernate

•	 Restart

•	 Cancel

•	 Shut Down

Select one of the options as desired. If no option is selected within 60 seconds, the 
recorder shuts itself down (see figure 10).

Figure 10.	 Mouse and Keyboard Shut Down Confirmation Window

Choosing the Controller Device
In any VN-Matrix system, one device needs to be configured as a controller. The 
controller acts as a central point of reference for each device, manages all of the system 
communications to every matrix device present, and also serves the web-based control 
interface to the user.

NOTE:	 The VNM Recorder is configured as a controller when shipped. The controller 
address is set to the same value as the eth0 port (192.168.254.254).

The controller can be one of the following devices.

•	 VN-Matrix 200, 225, 300, or 325 device which is suitable for small network systems

•	 VNM Recorder which is suitable for small network systems

•	 VNM Enterprise Controller which is suitable for large network systems

When a controller device has been chosen, all devices within the VN-Matrix system must 
reference the IP address of the controller device. When configuration of the VN-Matrix 
system is complete, the IP address of the controller device can be entered into a suitable 
web browser running on any PC or laptop connected to the VN-Matrix network.

For information on how to configure the VNM Enterprise Controller, see the VNM Enterprise 
Controller User Guide. For information on how to configure the VN-Matrix encoders and 
decoders, see the VN-Matrix 200 Series User Guide, VN-Matrix 225 Series User Guide,  
VN-Matrix 300 User Guide, and the VN-Matrix 325 User Guide.
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Configuring the VNM Recorder

NOTE:	 Initial configuration of the VNM Recorder requires a mouse, keyboard, and 
monitor. When configuration is complete, it is not necessary to keep these devices 
attached to the recorder. The recorder can be completely controlled using the web-
based user interface.

Default Network Settings
The VNM Recorder is pre-configured with the following network settings.

IP Address: 			   192.168.254.254 
Subnet Mask: 			   255.255.255.0 
Controller IP Address: 		 192.168.254.254

NOTE:	 Using these settings, the VN-Matrix encoder/decoder unit(s) must use  
IP addresses within the range 192.168.254.1 through 192.168.254.253 and use the 
same subnet mask. The default network settings can also be changed to match an 
existing network setup. This is explained in the following sections.

Configuring the Network and IP Address Settings
Use the following procedure to change the network settings on the VNM Recorder.

Stage 1 — Configure the network settings

1.	 If the recorder is not turned on already, power up the unit and wait for the login screen 
to appear on the monitor (approximately two minutes and fifteen seconds).

2.	 Enter in the administrator username and password at the login screen (see  
Login Information on page 14 for username and password information).

3.	 From the menu bar on the desktop, select System > Administration > Network. 
The Network Configuration window appears (see figure 11).

Figure 11.	 Network Configuration Window
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4.	 Select the eth0 (upper Ethernet connector; primary network) device line to highlight it. If 
there is a network cable present and it is connected to a switch, the status should read 
Active.

5.	 Click Deactivate. The status of the eth0 device should now read Inactive.

6.	 Double-click on the eth0 device. The Ethernet Device window appears (see figure 12).

Figure 12.	 Ethernet Device Window

7.	 Change the Address and Subnet mask fields as required and then click OK.

NOTE:	 The Default gateway address field is only required if devices are on 
different subnets.

8.	 Navigate back to the Network Configuration window (see figure 11). Select the  
eth0 device and then click Activate. 
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9.	 If changes were made, a dialog box appears asking to confirm the changes. Click Yes 
to confirm and save the changes (see figure 13).

Figure 13.	 Confirm Settings Window

10.	The following dialog box appears (see figure 14). Click OK to continue.

Figure 14.	 Settings Saved Window

11.	A loading dialog box appears and the necessary changes are made to the system. After 
the loading dialog box disappears, navigate back to the Network Configuration window 
and check that the status of the eth0 device now reads Active.

12.	Close the Network Configuration window.
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Stage 2 — Setting the controller IP address

1.	 If necessary, enter the administrator username and password at the login screen (see 
Login Information on page 14 for username and password information).

2.	 From the desktop, double-click on Computer > Filesystem > home > matrix_rec 
(see figure 15, 1, 2, 3, and 4).

3.	 Double-click on the folder that contains the latest release of the recorder software 
(5). At the time this guide was released, the latest software would be stored in the 
ver3.10.9 folder or in a folder with a similar name.

11111

22222

333 444

555

666

Figure 15.	 Navigating to the Recorder Software Folder

4.	 Click on the config.xml file to select it (6).

5.	 From the Edit menu, select Duplicate. This creates a backup copy (named  
config (copy).xml) of the original config.xml file. Keep the backup copy for system 
restoration purposes.

6.	 Right-click on the config.xml file and select the Open with "Emacs Text Editor" 
option.
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7.	 Near the bottom of this file are two values named st_controlIp and st_localIp0 with 
an IP address listed under each (see figure 16). Edit these values as follows.

•	 If the VNM Recorder is the controller device, edit both values to match the  
IP address (eth0) of the recorder.

•	 If the VNM Recorder is not the controller device, change the st_controlIp value 
to match the IP address of the controller device. Change the st_localIp0 value to 
match the IP address (eth0) of the recorder.

Edit this value to match

Edit this value to match

the IP address of the
controller device.

the IP address (eth0) of the
VNM Recorder.

Figure 16.	 Config.xml Text Window

NOTE:	 Be careful not to change any other values or remove any of the special 
formatting characters in this file.

8.	 Click on the save icon  or click on the File menu and select the  
Save (current buffer) option.

9.	 Close the text editor window and all other folder windows.
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Stage 3 — Restart the VNM Recorder

Restart the VNM Recorder. See VNM Recorder Power Down Procedure on page 15).

Configuring the VN-Matrix Encoders and Decoders
For the VNM Recorder to function properly, update each VN-Matrix device to point to the 
new IP address of the controller device. For information on how to configure the encoders 
and decoders, see the VN-Matrix 200 Series User Guide, VN-Matrix 225 Series User Guide, 
VN-Matrix 300 User Guide, and the VN-Matrix 325 User Guide.

NOTE:	 The VNM Recorder can operate with unicast (RTP and TCP) or multicast 
streams. Keep this in mind when setting up and configuring the encoders on a 
VN‑Matrix network.
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About the Web‑based 
User Interface

NOTE:	 It is important that all devices within the VN-Matrix network contain the same 
version of firmware to avoid communication and compatibility issues. Check that 
each device contains the same version of firmware by using the Device List (see 
page 26) of the web-based user interface. To update the VNM Recorder firmware, see 
Firmware Updates on page 63.

This section provides information on:

•	 Overview of the Web-based User Interface

•	 Accessing the Web-based User Interface

•	 Web-based User Interface Control Options

•	 Advanced Configuration

•	 VN-Matrix Encoder and Decoder Configuration

Overview of the Web-based User Interface
The web-based user interface is an application that is used to configure the devices in a 
VN-Matrix network. It is accessed by using a web browser and entering in the IP address 
of the controller device. The user interface allows for system level configuration and can be 
used with any VN-Matrix device that is connected to the controller device. The following list 
outlines the configuration options that are available.

•	 Configure all VN-Matrix devices that are connected to the controller device.

•	 Switch all VN-Matrix 200 / 225 / 300 / 325 codec devices from encoders to decoders 
and vice versa.

•	 Configure the type of compression that is applied to a stream.

•	 Choose the appropriate transport protocol that will be used between an encoder and a 
decoder.

•	 Configure the specific types of elements that are distributed over a PURE3 stream.
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Accessing the Web-based User Interface

NOTE:	 The user interface shown in this guide is available when using VN-Matrix 200, 
225, 300, or 325 devices or a VNM Recorder. This interface is best used when 
configuring small systems. For larger systems, using a VNM Enterprise Controller 
interface is recommended (see the VNM Enterprise Controller User Guide).

The web-based user interface can be accessed using a suitable web browser (for example, 
Microsoft® Internet Explorer® v7 or above or Mozilla® Firefox® v1.3 or above) running on 
any PC or laptop connected to the VN-Matrix network. With a web browser open, use the 
following steps to access the user interface.

1.	 Type in the IP address of the controller device into the address bar of the web browser 
(for example, http://192.168.254.254). The web page shown in figure 17 appears in the 
browser.

NOTES:

•	 If the VNM Recorder is configured as the controller device of the VN-Matrix 
network, the IP address must be appended with the port number that is used 
as the web page server (for example, http://192.168.254.254:8090).

•	 If the web browser cannot access the web-based user interface, the security 
settings of the web browser may need to be configured (see Browser 
Configuration on page 68).

Figure 17.	 Controller Login Page

2.	 Enter the appropriate username and password.

NOTES:

•	 By default, these are both set to admin.

•	 For information on how to change the password, see Accounts Page on 
page 41.
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3.	 Click Log In or press <Enter> on the keyboard. The Device List page appears  
(see figure 18).

Figure 18.	 Device List Page

For more information on how to control and navigate the user interface, see  
Web-based User Interface Control Options below and Advanced Configuration 
on page 38.

NOTES:

•	 The system can be logged out of at any time using any of the interface pages. 
Click on the Logout tab to exit the user interface or simply close the web 
browser.

•	 If configuration changes were made to the system, it is recommended to click 
on the Save All tab before logging out.

Web-based User Interface Control Options
This section details the user interface pages that are associated with the VNM Recorder and 
describes what they are commonly used for. The pages associated with the VNM Recorder 
are listed below.

•	 Device List Page

•	 Recorder Device Page

•	 Recorder Page

•	 Navigate Page

•	 Player Page
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Device List Page
The Device List page lists all of the VN-Matrix devices detected on the network. This is also 
the first page that is seen after logging in (see figure 19).

444 555 666 777111 222 333

Figure 19.	 Device List Page

NOTE:	 If devices are added after the page has been displayed, they may not 
automatically appear on this list. Refreshing the page or clicking on the Device List 
tab updates the list.

When a VN-Matrix device has been detected and listed on the Device List page, an entry 
will be displayed even if the device is subsequently disconnected. All valid devices are listed 
by device name and followed by their current IP address.

NOTE:	 Some listed devices may not show an IP address. These devices are known as 
inactive devices. A device is considered inactive if it is disconnected from the network 
or powered down.

1	 Device Icons — There are seven types of device icons.

NOTE:	 VN-Matrix 200 and 225 devices use the same icons shown below.

  —  A five channel VNM Recorder.
 

  —  A VN-Matrix 2xx series codec device with DVI input or output.
 

  —  A VN-Matrix 2xx series encoder device with DVI input or output.
 

  —  A VN-Matrix 2xx series decoder device with DVI input or output.
 

  —  A VN-Matrix 300 series codec device with 3GSDI input or output. 
                             The text after the hyphen details the video signal type.
 

  —  A VN-Matrix 300 series decoder device with 3GSDI input or 		
 	 output. 
                             The text after the hyphen details the video signal type.
 

  —  A VN-Matrix 325 codec device.
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2	 Mode Icons — The current configuration status of each device is identified by an icon.

?  
An undefined device.

 
 

A device configured as an encoder (source).

 

 
A device configured as a decoder (display). 
 

 
A VNM Recorder.

3	 Alarm Status Icons — The alarm status of a device is indicated by a colored icon. For 
more information on alarm statuses, see "About Alarms" on page 55 or click on the 
Alarms tab and then click on the Help tab within the web-based user interface.

 
A device which has not contacted the controller this session.

 

 
A device under active control with no alarms. 

 

 
A device under active control showing warning alarms. 

 

 
A device under active control showing critical alarms.

4	 Name — The device name is shown in this column. To change the name of the device, 
see the "Recorder Device Page" section on page 28.

5	 IP Address — The IP address of the device is shown in this column.

NOTE:	 The IP address of the device is only shown if the device is currently present 
on the network and configured to use the controller.

6	 Version — This column shows the current firmware version installed onto each device.

NOTE:	 To avoid compatibility issues, all devices must have the same version of 
firmware installed onto each device.

7	 Del — This column is used to remove devices from the VN-Matrix network. Clicking on 
the red X icon brings up a confirmation dialog. Click OK to delete the selected device 
from the database. Devices can only be deleted when the physical device is not actively 
being managed and when active connections have been disconnected from the device. 
Before deleting the device, the system carries out an implicit "save all" action to ensure 
that the current and persistent databases remain up-to-date.
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Recorder Device Page
This page is accessed by selecting the VNM Recorder device on the Device List (see 
page 26).

111 222

333 444

Figure 20.	 Recorder Device Page

The Recorder Device page shows the basic status for a VNM Recorder device. The device 
information is presented in four panels.

NOTE:	 This guide references the Device page for the VNM Recorder only. See the other 
device user guides or click on the Help tab for information on device specific control 
options.

1	 Device Summary panel — This panel indicates the connection status of the device 
and the status of the management link between the device and the system controller.

•	 Name — The device name can be modified by typing in a new name into this field 
and clicking Update. The name should be comprised of letters, numbers and the 
underscore character. Spaces should be avoided.

•	 Serial Number — The field displays the serial number of the device.

•	 Device Status — This field indicates the management state of the device. Normally 
it should show Active, but if the device is missing or it cannot be contacted via the 
controller it will show No Device.

•	 IP address:port(cport) — This field displays the IP address of the current device,  
the UDP port the device is using to communicate with the controller, and the 
controller UDP port it is contacting.

•	 Link Status — When a device is active, this field displays the quality of the 
management link between the device and the system controller. A link status of 
Good indicates little or no management packet loss. A link status of Fair indicates 
a small amount of packet loss. A link status of Poor indicates a bad link; investigate 
whether the link to the device has sufficient bandwidth to carry the data and 
management traffic. 
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2	 Device Setup panel — This panel controls various global actions for the device. 

•	 Device Type — This field will always display storage as the device type for the  
VNM Recorder and cannot be changed.

NOTE:	 When this field displays none, source, or display, it means that the 
device is a codec, encoder, or decoder.

•	 Mode — A device can be configured using four modes.

NOTE:	 This configuration option is not available for the VNM Recorder. These 
modes are detailed for reference purposes.

•	 enable — This is normal operation. 

•	 disable — Using this mode on a source device stops streaming to the 
network, but still shows pass-through output. Using this mode on a display 
device outputs a splash screen in place of normal data. 

•	 standby — Using this mode on a source device stops streaming and disables  
pass-through output. Using this mode on a display device disables all output. 
VN-Matrix 300 / 325 devices do not support standby mode.

•	 test — Using this mode on a device (source or display) shows a splash screen 
with the words "Test Mode". Normal streaming is suspended.

•	 Data Interface — This option allows the streaming interface to be specified. 
Currently, the only option available is Cat6, which uses the eth0 (primary)  
network interface.

•	 Multicast TTL — This field is used to specify the number of hops multicast traffic 
will make between routed domains when it exits a source. It is not used for TCP or 
unicast RTP traffic and is only used on a source.

3	 Licensed Features panel — This panel is used to manage the device license and 
indicates what features the user has access to. If the device has an incorrect checksum 
for the licensed features, a license error message will be shown and the device will not 
support streaming functions.

NOTE:	 The VNM Recorder contains a default license that allows for five recorder 
channels and five player channels. It is currently not possible to change the device 
license on the VNM Recorder (see Controller Licensing on page 42).

ATTENTION:	 DO NOT place information for a VNM Enterprise Controller license 
into this menu. Doing so causes the device to stop responding.

ATTENTION:	 Ne pas mettre d'informations pour une licence VNM contrôleur 
entreprise dans ce menu. Si c'est le cas l'appareil risque d'arrêter de répondre.

4	 Configuration panel — This panel indicates what features the user is able to control. 
Each device consists of a number of components which are accessed by clicking on 
the appropriate links.

 
The Recorder icon accesses the pages that manage the recording of VN-Matrix 
PURE3 streams to the VNM Recorder hard disk.
 

 
The Player icon accesses the pages that manage the playback of previously 
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recorded VN-Matrix PURE3 streams.

Recorder Page
This page is accessed by selecting the VNM Recorder device on the Device List page  
(see page 26) and then clicking the Recorder icon located on the Configuration panel of the 
Recorder Device page (see page 28).
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Figure 21.	 Recorder Page

The Recorder page controls the recording functionality of the VNM Recorder. The recorder 
is capable of recording up to five simultaneous channels. Each channel contains one video 
stream. In addition, a channel may also contain audio and data elements if these are present 
and enabled at the encoder. 

NOTES:

•	 The audio and data elements can be recorded, but in order to do so, those 
elements must be selected using the appropriate check boxes (audio, wb, and 
data).

•	 The ability of the VNM Recorder to record multiple streams depends on the 
bandwidth of the source data streams and the disc writing capability of the recorder 
hardware.

1	 name — The device name can be modified by editing this field and clicking Update. 
The name should be comprised of letters, numbers, and the underscore character. 
Spaces can be used, but should be avoided if possible.

2	 Storage Path — Data is recorded in the directory specified in this field. This is modified 
on the Navigate page that can be accessed by clicking on either the Storage Path link 
or the Navigate tab at the top of the Recorder page. For more information on changing 
the storage path (see Navigate Page on page 32).

3	 Bookmark button — Clicking on this button during a recording sets a reference point 
within the stream that can be retrieved later. A new reference point is placed within the 
stream each time the button is pressed and allows for multiple reference points to be 
set (see Using Bookmarks on page 54).

NOTE:	 The bookmark button on this page only works while recording a stream.

4	 Bandwidth — This drop-down menu is used with the Bandwidth tab. Select a channel 
and a source element from the menu and use the Bandwidth tab to monitor bandwidth 
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statistics. For more information on monitoring bandwidth, see the VN-Matrix 200 Series 
User Guide, VN-Matrix 225 Series User Guide, VN-Matrix 300 User Guide, and the  
VN-Matrix 325 User Guide.

5	 channel — There are five channels that can be used for recording. Each recorder 
channel contains the following parameters.

NOTE:	 Channel 1 must always be used when recording. When using multiple 
recording channels, use them in consecutive order and do not skip channels. For 
example, assign three recordings to channels 1, 2, and 3. DO NOT assign the 
recordings to channels 1, 3, and 5 or to a similar configuration where one or more 
channels are skipped.

•	 source — This drop-down menu is used to select the RTP or TCP stream of each 
available VN-Matrix stream.

•	 group — Checking this box allows channel recordings to be grouped together. 
Grouped channels start, record, and stop together. 

•	 audio — Checking this box enables synchronized recording of the audio channel.

•	 wb — Checking this box enables the recording of whiteboard (annotation) data. 
See Definitions on page 7 for more information.

•	 data — Checking this box enables the recording of user data (see Definitions).

•	 filename — This field is used to name the recording. The name of the file appears 
in the Content Directory and is placed at the beginning of all recorded elements for 
that channel.

•	 description — This field is used to enter important information about a recording. 

•	 record — Check this box and click the Update button to start a recording. 
Uncheck this box and click the Update button to stop a recording. Grouped 
channels will start and stop together.

•	 time — While recording, the length of time that has been recorded is displayed.

 

VNM Recorder • About the Web-based User Interface 31



•	 MB — While recording, the size of the recorded stream is displayed in megabytes.

Navigate Page
This page is accessed by selecting the VNM Recorder device on the Device List page  
(see page 26), clicking the Recorder icon located on the Configuration panel of the 
Recorder Device page (see page 28), and clicking on the Navigate tab.
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Figure 22.	 Navigate Page

ATTENTION:	 It is possible to access directories that contain critical files that should 
not be modified at all. Care must be taken when using the control options available on 
this page.

ATTENTION:	 Il est possible d’accéder à des index qui contiennent des fichiers 
essentiels qui ne doivent absolument pas être modifiés. Une attention particulière doit 
être portée lors de l’utilisation des options de contrôle accessibles sur cette page.

The Navigate page provides simple file manager capabilities for the VNM Recorder. This 
page is primarily used to set the default location that is used to store recordings as well as 
to create or delete directories and files.

1	 Content Directory — The Content Directory allows for content selection and 
navigation between directories. The Content Directory should be used when using the  
configuration options on this page (see About the Content Directory on page 43).

2	 Update Storage Path — Clicking on this button takes the storage path specified in the 
Update Path field and assigns it as the current file storage location.
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3	 Group Recordings — A recording file is made up of a group of files sharing a common 
prefix all grouped together into a directory. 

•	 When the Group Recordings box is checked, the content directory lists a logical 
view of each type of stream that is present in the recording (this is the default 
setting). Each stream type is represented by an icon in the Type column. The 
Tag column contains the text that was entered in the description field on the 
Recorder page (see Recorder Page on page 30).

•	 When the Group Recordings box is unchecked, the content directory lists the 
actual directories that are created for each element type of a recording. In this view, 
it is possible to access the individual files that make up the recorded stream.

NOTE:	 The Player page (see page 35) automatically enables group recordings.

4	 Update Path — Use this field to set the recording storage location.

NOTE:	 The default storage path of the VNM Recorder is set to  
/home/matrix_rec/Recording_Files. This is the recommended path where all 
recordings should be stored. 

1.	 Use the Content Directory to navigate to the appropriate location. The Update 
Path field automatically updates to confirm the selected location.

2.	 Click the Update Storage Path button to assign the storage location.

3.	 Click the Save All tab to save and set the default storage location.

- OR -
1.	 Manually type in the location of the directory into this field.

NOTE:	 When typing in a directory or file location, it must contain the exact 
characters. Characters are case sensitive.

2.	 Click the Update Path button to go directly to the specified location.

3.	 Click the Update Storage Path button to assign the storage location.

4.	 Click the Save All tab to save and set the default storage location.

5	 Delete Selection — Use this field to delete files or directories. 

NOTES:

•	 Incorrect use of the delete function will cause the VNM Recorder to become 
unstable. This feature should only be used by an experienced technician.

•	 A directory can only be deleted when it is empty.

1.	 Use the Content Directory to navigate to the appropriate location.

2.	 Click on the appropriate radio button in the Sel column to select the file that needs 
to be deleted.

3.	 Click Delete Selection.

4.	 A prompt appears asking to confirm the deletion. Click OK to delete the selection.

- OR -
1.	 Manually type in the location of the file or directory into this field.

2.	 Click Delete Selection.

3.	 A prompt appears asking to confirm the deletion. Click OK to delete the selection. 
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6	 Make Directory — Use this field to add a new directory.

NOTE:	 It is recommended that a new directory is created for each recording so that 
they are easier to identify and retrieve for playback.

1.	 Use the Content Directory to navigate to the appropriate location.

2.	 Enter the name of the new directory into the Make Directory field. 

3.	 Click Make Directory to create the new directory.

- OR -
1.	 Manually type in the location of where the new directory will be placed, followed  

by the name of the new directory (for example, /home/matrix_rec/ 
Recording_Files/test).

2.	 Click Make Directory to create the new directory. In the example above, the 
name of the new directory is called test and is located in the Recording_Files/
Techpubs directory path.

7	 Rename Selection — Use this field to rename a file or directory. 

NOTE:	 Incorrect use of the rename function will cause the VNM Recorder to 
become unstable. This feature should only be used by an experienced technician.

1.	 Use the Content Directory to navigate to the directory of the file to be renamed.

2.	 Click on the appropriate radio button in the Sel column to select the file that needs 
to be renamed. The filename appears in the first text field next to the Rename 
Selection button. DO NOT rename the file using this field.

3.	 Using the second field, type in the desired name for the file.

4.	 Click Rename Selection to rename the file.
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Player Page
This section is obsolete. Please see the Enterprise Controller User Guide (available at 
www.extron.com) for complete instructions.

Advanced Configuration

Config Page
This section is obsolete. Please see the Enterprise Controller User Guide (available at 
www.extron.com) for complete instructions.

Accounts Page
Access this page by selecting the Accounts tab on the Device List page (see page 26).
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Figure 23.	 Accounts Page

The Accounts page is primarily used to change the password that is used for logging into 
the designated controller device of the VN-Matrix system. This page is also used to manage 
the license that is assigned to the controller device and adjust the internal clock.
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Changing User Login Passwords

There are two accounts that can be used for logging into the controller device.

1	 Administrator — Allows full read and write access to all configuration options. The 
default password for this account is admin (which is the same as the username).

2	 Public — Allows read only access to configuration options. The default password for 
this account is public (which is the same as the username).

NOTES:

•	 Passwords can only be modified when the user is logged in with the 
Administrator account. If the user is logged in with the Public account, 
password modification fields will be disabled.

•	 The username and password entries are case sensitive.

•	 The username entries cannot be changed.

•	 The Recorder GUI account is not required for normal operation. For 
information on this account, call the Extron S3 Sales and Technical Support 
Hotline and ask for an Applications Engineer.

Use the following procedure to change the password for either account.

1.	 Enter the current password in the Current Password field.

2.	 Enter the desired password in the New Password field. The password should consist of 
letters, numbers, and the underscore character. Password entries are case sensitive.

3.	 Re-enter the password in the Confirm field.

4.	 Save the new password by clicking Update Passwords.

NOTE:	 Account passwords can be changed simultaneously, if desired. Repeat 
steps 1 through 3 above for each account that requires a different password. Click 
on Update Passwords to update passwords simultaneously.

3	 Clock Management

The Current Time field displays the date and time the user interface page was served.

Use the New Time field to update the date and time. Use the following guidelines and 
refer to figure 23 on the previous page when updating the date and time. 

•	 The entry should be input in an identical format shown in the Current Time field:  
year-month-date hours-minutes-seconds. 

•	 The year should include the century (for example, 2012). 

•	 The month is represented by a two digit number from 01 through 12.

•	 The date is represented by a two digit number from 01 through 31.

•	 Hours are represented by a 24 hour clock using two digit numbers from  
00 through 23.

Click on Change Time to save the date and time entered in the New Time field.
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4	 Controller Licensing

ATTENTION:	 DO NOT place information for a device license into this area. 
Doing this may cause the VNM Recorder to stop responding. This area is used 
for controller licenses only (see the Licensed Features panel on page 29 for 
information about device licenses).

ATTENTION:	 Ne placez PAS d’informations sur une licence d’appareil à cet 
endroit. Cela pourrait bloquer la communication avec l’enregistreur VNM. Cette 
zone est réservée aux licenses des contrôleurs uniquement (voir le tableau 
Licensed Features à la page 29 pour obtenir des informations sur les licences 
des appareils).

In addition to each device containing a device license, the VN-Matrix system also 
includes a controller license. The controller license manages the number of  
connections that can be made simultaneously when using the VNM Software Decoder 
(part number 29-098-01).

To obtain a new controller license, follow the procedure below:

1.	 Contact the Extron S3 Sales and Technical Support Hotline and provide the 
following information.

•	 The serial number of the VN-Matrix device configured as the system 
controller. This can be obtained from the back of the device.

•	 The order number of the VN-Matrix device.

2.	 The Extron S3 Sales and Technical Support Hotline provides an options key and a  
checksum.

•	 Enter the options key into the Options field.

•	 Enter the checksum into the Checksum field.

3.	 Click Change License to save the new license.

VN-Matrix Encoder and Decoder Configuration
The user interface pages discussed in this guide are associated with the VNM Recorder. The 
VN-Matrix encoders and decoders may need to be configured using the other pages of the 
web-based user interface for the system to operate properly. For more information on how 
to configure the encoders and decoders, see the VN-Matrix 200 Series User Guide,  
VN-Matrix 225 Series User Guide, VN-Matrix 300 User Guide, and the VN-Matrix 325  
User Guide.
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About the Content 
Directory

This section discusses how to use the Content Directory for organizing and locating 
files. The following sections give an overview of how it is used and details some of the 
functionality of the Content Directory.

This section provides information on:

•	 Overview

•	 Content Directory Basics

•	 Setting a Stream Storage Location

•	 Creating a Directory

•	 Understanding Saved Recordings With Multiple Elements

•	 Renaming a Stream or Directory

•	 Deleting a Stream or Directory

Overview
The Content Directory allows for content selection and navigation between directories. This 
directory can also be used to see how the file structure of a recording system is set up.

NOTE:	 The Content Directory is shared between the Player page, and Navigate page 
(see page 32). The Content Directory may display incorrect information if the directories 
and files within these pages are changed at the same time using different browser 
windows.
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Figure 24.	 Navigate Page — Content Directory

Figure 24 shows the Navigate page with a list of recorded files and contains the following 
settings:

•	 The Group Recordings check box is selected (by default).

•	 The default storage path is initially set to /home/matrix_rec/Recording_Files. This is the 
path where all recordings should be stored. To change the storage path, see Update 
Path on page 33 of the Navigate Page section.

Content Directory Basics
A single directory or filename can be selected by clicking on the radio button to the left of 
the directory or filename. Selecting directories or filenames using this method also fills in the 
Delete Selection and Rename Selection fields and is a useful alternative to the user 
having to manually type in the location of a directory or file. 

To move around within the directory, use the following navigation controls.

•	 Click on a folder name to see the files within the folder.

•	 Click Default Path to return to the root directory.

•	 Click the . link to display the root directory.

•	 Click the .. link to move up to the parent directory.

•	 Click the folder icon to refresh the listing.
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Switching between directories may take some time and the folder icon changes to a loading 
icon while waiting. After the directory has loaded, the Update Path field is updated with 
the current location. If the directory is not made available after ten seconds, an alert icon is 
displayed (see the icons below). 

 
Folder Icon

 
Loading Icon

 
Alert Icon

NOTE:	 When a directory is not found or unable to be displayed, try refreshing the page 
using the Navigate tab. Alternatively, click Default Path which resets the Content 
Directory listing.

Bookmarks can also be viewed using the Content Directory (see Using Bookmarks on 
page 49).

Setting a Stream Storage Location
See Update Path on page 33 of the Navigate Page section for information.

Creating a Directory
See Make Directory on page 34 of the Navigate Page section for information.
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Understanding Saved Recordings With Multiple Elements

Figure 25.	 Navigate Page — Multiple Element Recording

When a recording contains multiple elements (such as video, audio, data, and whiteboard), 
the stream is saved as multiple directories containing multiple files.

Figure 25 shows an example of a stream that has been saved using multi-channel 
recording, viewed on the Navigate page of the web-based user interface. Information to 
note from figure 25 includes:

•	 The Tag column displays the text that was entered in the description column on the 
Recorder page (see page 30).

•	 The Date, Time, and Length columns all show the same value, indicating that these 
files are part of a single recording.

•	 The same encoder was used as a source for all five channels.

•	 The files are organized by channel and are listed in order from 1 to 5.

•	 The files for each channel are listed with the video content listed first, followed by the 
audio content.

The file naming table on the next page explains how filenames are created by the  
VNM Recorder software. This table can also be used to determine what element is 
contained within the file. 
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File Naming Table

Channel Number Filename Section Description

1

CH1_M_UXGA_Audio_M
This is the text that was entered by 
the user in the filename column on 
the Recorder page (see page 30).

620032.0.0_r0_s0

This is entered automatically by the 
VNM Recorder software.
•	 620032 = The serial number of the 

encoder unit

•	 0.0_r0_s0 = This stream contains 
video for channel 1

CH1_M_UXGA_Audio_M
This is the text that was entered by 
the user in the filename column on 
the Recorder page (see page 30).

620032.A0.0_r1_s0

This is entered automatically by the 
VNM Recorder software.
•	 620032 = The serial number of the 

encoder unit

•	 A0.0_r1_s0 = This stream contains 
audio for channel 1

2

CH2_M_UXGA_Audio_M
This is the text that was entered by 
the user in the filename column on 
the Recorder page (see page 30).

620032.0.0_r6_s0

This is entered automatically by the 
VNM Recorder software.
•	 620032 = The serial number of the 

encoder unit

•	 0.0_r6_s0 = This stream contains 
video for channel 2

CH2_M_UXGA_Audio_M
This is the text that was entered by 
the user in the filename column on 
the Recorder page (see page 30).

620032.A0.0_r7_s0

This is entered automatically by the 
VNM Recorder software.
•	 620032 = The serial number of the 

encoder unit

•	 A0.0_r7_s0 = This stream contains 
audio for channel 2

NOTE:	 This table only uses the first two channels to illustrate how filenames are 
created by the VNM Recorder software.

Renaming a Stream or Directory
See Rename Selection on page 34 of the Navigate Page section for information.

Deleting a Stream or Directory
See Delete Selection on page 33 of the Navigate Page section for information.
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Recording and 
Playing Streams

NOTE:	 It is recommended that all devices within the VN-Matrix network contain the 
same version of firmware to avoid communication and compatibility issues. Check that 
each device contains the same version of firmware by using the Device page of the 
web-based user interface. To update the VNM Recorder firmware, see the Firmware 
Updates section on page 63.

This section provides information on:

•	 Initial Setup and Configuration

•	 Recording a Stream

•	 Playing a Recorded Stream

•	 Using Bookmarks

If necessary, refer to the information in the Web-based User Interface Control Options 
section on page 25 while following the various procedures below.

Initial Setup and Configuration
This section talks about how to set up each VN-Matrix as a decoder or encoder.

NOTE:	 All connections (streams) must be removed from the VN-Matrix system before a 
codec can be assigned as an encoder or a decoder.

Setting up a VN-Matrix Codec as a Decoder
1.	 From the Device List page (see page 26), click on a VN-Matrix codec device. The 

Device page appears.

2.	 In the Device Setup section, click create display (see figure 26, 1). If the Device 
Setup section is not visible, click change device type to change the view.
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Figure 26.	 Device Setup

3.	 Click the display0 icon. The Display page appears.
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4.	 In the Source drop-down menu, choose the appropriate source (see figure 27, 1). 
This can be a playback channel source streaming from the VNM Recorder device or a 
source streaming from a VN-Matrix encoder.
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Figure 27.	 Choose the Video Source

NOTE:	 The playback channels are identified by the recorder device name using the 
names video-player0 to video-player4. For a single channel record or playback 
system, always choose video-player0.

5.	 Click Update (see figure 27, 2).

6.	 Click the Save All tab in the top menu bar. The codec is now configured as a basic 
decoder. For information on advanced decoder setup, see the VN-Matrix 200, 225, 
300, or 325 user guides.

Setting up a VN-Matrix Codec as an Encoder
1.	 From the Device List page (see page 26), click on a VN-Matrix codec device. The 

Device page appears.

2.	 In the Device Setup section, click create source (see figure 28, 1). If the Device 
Setup section is not visible, click change device type to change the view.
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Figure 28.	 Create Source

3.	 Click the Save All tab in the top menu bar. The codec is now configured as a basic 
encoder with an auto-detect source input mode. For information on advanced encoder 
setup, see the VN-Matrix 200, 225, 300, or 325 user guides.
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Switching a Codec between Encoder and Decoder
1.	 From the Device List page (see page 26), click on a VN-Matrix codec device. The 

Device page appears.

2.	 Click change device type (see figure 29, 1).

NOTE:	 All connections (streams) must be removed from the codec before it can be 
assigned as an encoder or a decoder.

111

Figure 29.	 Change Device

3.	 Click create source to load the encoder configuration, or create display to load 
the decoder configuration.

4.	 Click the Save All tab.

Recording a Stream
When a recording is created, each element that is present within a stream is stored as an 
individual file under the same directory. A recording that contains a single element (such 
as video) will only require a single file. When a recording contains multiple elements (such 
as video, audio, data, and whiteboard), the stream will be saved as multiple files (see 
Understanding Saved Recordings With Multiple Elements on page 41).

Recording Preparation
To prepare a stream for recording, follow the procedure below.

NOTES:

•	 Before recording, it is recommended to set the stream storage location (see 
Update Path on page 33).

•	 It is recommended that a new directory is created for each recording so that 
associated files are easier to locate (see Make Directory on page 34).

1.	 Ensure that the VN-Matrix codec is configured as an encoder (see Setting up a 
VN‑Matrix Codec as an Encoder on page 49).

2.	 From the Device List page (see page 26), click on the VNM Recorder device.

The Recorder Device page (see page 28) appears.

3.	 From the Recorder Device page (see page 28), click the Recorder icon.  
The Recorder page (see page 30) appears. 
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4.	 Using the source drop-down menus, choose the VN-Matrix encoder devices that will 
be recorded from.

NOTE:	 Channel 1 must always be used when recording. For a single channel 
record/playback system, use channel 1 only.

5.	 Enter a filename for the stream and an optional description.

6.	 To record an associated audio stream, check the audio box. The ability to record 
associated whiteboard or data streams can also be checked if these elements are 
available on the source.

NOTES:

•	 The timing relationship of the elements contained within the stream is 
maintained by the recorder.

•	 The information from each recorded element is placed into its own folder 
within the chosen directory. If necessary, those folders can be opened and the 
individual files of each recorded element can be viewed.

Initialize Recording
To start recording, check record (figure 30, 1) and click Update (2).
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Figure 30.	 Initialize Recording

NOTE:	 Recording does not actually start until Update is clicked. While recording is in 
progress, the time and MB (file size) values steadily increase.

Stop Recording
To stop recording, clear the record check box and click Update.

NOTE:	 Recording does not actually stop until Update is clicked.

Creating Still Frames from a VN-Matrix Video Recording
The gcode Frame Translator Utility allows existing VN-Matrix video recordings to be 
converted to a series of individual still frames (see gcode Frame Translator Utility 
Instructions on page 71).

 

VNM Recorder • Recording and Playing Streams 46



Playing a Recorded Stream
All elements of a recording are loaded when a recorded file is selected for replay at a later 
time and cannot be separated from the recording. The video element is always replayed. 
The optional elements may be enabled or disabled for replay, provided they are present in 
the original recording.

Playback Preparation
To prepare a stream for playback, follow the procedure below.

1.	 Ensure that the VN-Matrix codec is configured as a decoder with a VNM Recorder 
channel set as the Source device (see Setting up a VN-Matrix Codec as a Decoder 
on page 43).

2.	 From the Device List page (see page 26), click on the VNM Recorder device. The 
Recorder Device page (see page 28) appears.

3.	 From the Recorder Device page (see page 28), click the Player icon. The Player 
page (see page 35) appears.

4.	 In the Listing Directory, click on the media stream that will be played back. The stream 
appears on channel 1 (see figure 31, 1). 
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Figure 31.	 Player Page

See About the Content Directory on page 38 for more information on how to 
navigate within the directory.

NOTES:

•	 If the listing section (see figure 31, 2) is empty, click the folder icon to refresh 
the list. Also be sure to check that the listing section is not minimized by 
clicking on the Listing tab.

•	 The Listing Directory shows the contents of the location indicated by the 
Current Path field. This will be the last location visited on the Player page 
(page 35), or Navigate page (page 32).

•	 The Current Path field defaults to the folder that is saved as the default 
storage location (see Setting a Stream Storage Location on page 45).
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Initialize Playback
•	 From the Player page (see page 35), play a media stream by clicking Play.

Pause Playback
•	 To pause a stream, click Pause.

•	 To resume playback, click Play. Playback will continue from the point where it was 
paused.

Stop Playback
•	 To stop a stream, click Stop.

NOTE:	 Clicking Play following a Stop operation will initiate playback from the start 
of the media stream.

When playback is paused or stopped, the VN-Matrix decoder will behave as if the source 
data stream has stopped. If the NoData Splash feature is enabled on the decoder, the 
display will show the "No Source Datastream" message until playback resumes.

Disabling the NoData Splash feature will instead display the last frame of video received. 
This has the effect of simulating a true pause of the playback.

NOTE:	 For more information on the NoData Splash feature, see the  
VN-Matrix 200 / 225 / 300 / 325 user guides.

Start and Finish Times
When a stream is selected for playback, the start and finish times are populated with the 
original start and finish times of the recording. 

If required, it is possible to play back only a part of the original stream by entering different 
start and finish times.

•	 Change the start and finish times as required and click Update.

•	 To recall the original times, reopen the file.

Auto Repeat
•	 By default, a stream will play through once from start to finish.

•	 By selecting the auto repeat check box, the stream will loop continuously.
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Using Bookmarks
Bookmarks are used to set and quickly retrieve reference points within a stream. When 
a bookmark is created, it is stored in the Content Directory. Bookmarks are created by 
pressing the Bookmark button while recording a stream using the Recorder page (see 
page 30) or while playing back a previously recorded stream using the Player page (see 
page 35).

NOTES:

•	 Bookmarks are only visible in the same directory as their content material.

•	 Bookmarks cannot be renamed.

•	 Bookmarked streams are found on the Player page (see page 35) and the 
Navigate page (see page 32).

File Structure
When a bookmark is created, the file consists of the name of the recorded content prefixed 
by "BMn-" and a bookmark icon is displayed under the file type. 

NOTE:	 A bookmark is always represented as a single file while viewing the Content 
Directory. This is also relevant to bookmarked files that were created using multiple 
recording or playback channels.

Playback of Bookmarked Streams
Use the following procedure to play back a bookmarked stream.

1.	 From the Player page (see page 35), use the Content Directory to select a bookmark. 
This loads the recording and any additional channels that were used to create the 
bookmark.

2.	 Press the Play button to play back the bookmarked stream.

NOTE:	 If a bookmark is selected while a file is playing, it will not be activated until the 
original file is stopped by pressing the Stop button, then pressing the Play button.

Deleting Bookmarks
See Delete Selection on page 33 of the Navigate Page section for information.
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About Alarms

NOTE:	 Simple Network Management Protocol (SNMP) is not compatible with the  
VNM Recorder and not covered in this user guide. For information on using SNMP, 
see the VN-Matrix 200 Series User Guide, VN-Matrix 225 Series User Guide, 
VN‑Matrix 300 User Guide, and the VN-Matrix 325 User Guide.

This section provides information on:

•	 Overview

•	 Alarms Page

•	 Alarm Logs Page

•	 Alarm Reference Tables

Overview
The VN-Matrix system is configured to generate alarms for error conditions. A list of these 
error conditions and their meanings are presented on the following pages. 

Alarms can be monitored using the web interface at the following locations.

•	 On the Alarms page in the list that is immediately below the Filter Settings box. This 
details the alarm conditions that are currently active on the system.

•	 On the Alarm Logs page in the list that is immediately below the Filter Settings box. This 
provides a historical log of when an alarm condition was raised and cleared. 

•	 On the Device List page where a traffic light system represents the status of connected 
devices.

•	 On the top right hand corner of each page in the web interface where the device status 
and system status is displayed. 

Alarm conditions, when triggered, remain active for the entire duration of the error condition 
and for an additional five seconds after the error has cleared.
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Alarms Page
This page is accessed by selecting the Alarms tab on the Device List page (see page 26).

Figure 32.	 Alarms Page

The Alarms page enables a user to define and monitor system alarms.

Filter Settings

Figure 33.	 Filter Settings Panel

The Filter Settings panel allows the default settings for each alarm type to be modified. 

•	 Alarm Type — Select the particular alarm that is to have its default setting changed 
(see Alarm Type on page 52).

•	 Alarm Source — Select the device where the alarm is to change. Alarm filters may be 
set for either a single, specific unit or for all VN-Matrix 200, 225, 300, or 325 devices in 
the system. 

•	 Alarm Severity — Set the alarm severity. Each alarm condition has a default severity 
which may be overwritten using the filter controls. The default setting is shown in this 
drop-down menu (see Alarm Severity on page 52).

•	 Alarm Reporting — Set the alarm to be either "reporting" or "not reporting". Each 
alarm condition has a default reporting setting. The default setting is shown in this  
drop-down menu.
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Alarm Type
This drop-down menu lists the available alarm error conditions for all units. Alarm error 
conditions are divided into two categories:

•	 Alarm errors that occur on an encoder

•	 Alarm errors that occur on a decoder

In addition, there is one alarm error that only occurs on the device that is configured as the 
system controller.

See the Alarm Reference Tables section on page 55 for more information.

Alarm Severity
Alarms may be set to one of three severities.

Alarm Severity Description

Critical A red colored traffic light indicator for the device (see Alarm Status 
Icons on page 27) is displayed.

Warning When triggered, a warning alarm will result. An amber colored traffic 
light indicator for the device (see Alarm Status Icons) is displayed. 

None A setting of Default (None) effectively filters the alarm condition. 
The alarm still appears in the alarms list, but it will not affect any 
colored indicators.

Applying Alarm Filter Settings
Apply the alarm filter settings by clicking Apply Filter Change. 

NOTE:	 Changes will be lost after the VN-Matrix system is powered down unless the 
Save All tab is clicked to make changes permanent.
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Alarm List
The alarm list provides information on all alarm events that are currently active. The alarm list 
is refreshed each time the Alarms tab is selected and is located at the bottom of the Alarms 
page.

Alarm events that are listed may be sorted by Type (see figure 34, 1), Raise Time (2), 
and Severity (3). To change the order of the alarm list, left-click the desired heading. The 
list is refreshed each time the sorting criteria is applied.

111 222 333

Figure 34.	 Alarms Page — Alarm List Sorting
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Alarm Logs Page
This page is accessed by selecting the Alarms tab on the Device List page (see page 26) 
and then selecting the Alarm Logs tab.

111 222 333

Figure 35.	 Alarm Logs Page

The Alarm Logs page provides data on when an alarm condition was raised and cleared.

The log holds a historical record of the last 200 alarm events. When more than 200 events 
occur, the oldest event is deleted from the log.

Alarm events that are listed may be sorted by Type (see figure 35, 1), Raise Time (2), 
and Severity (3). To change the order of the alarm list, left-click the desired heading. The 
list is refreshed each time the sorting criteria is applied.
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Alarm Reference Tables

Alarm Type Description — Encoder

Alarm Type Description Action Default Settings

No source No source present at the input. Check input connections; is 
there an output on the loop 
through connector?

Critical, reporting

Bad source syncs Source is present, but  
unrecognized due to bad sync 
measurement.

Critical, reporting

No SDI source 
lock

Source is present, unable to lock.

Applicable to the  
VN-Matrix 300 / 325,  
ignore for VN-Matrix 200 / 225.

Critical, reporting

Unsupported SDI 
mode

Source is present, mode not  
supported.

Applicable to the  
VN-Matrix 300 / 325,  
ignore for VN-Matrix 200 / 225.

Critical, reporting

Unsupported 
mode

Source is present, mode not  
supported.

Critical, reporting

Bad source Critical, reporting

Analog phasing  
error

Warning, reporting

Hardware 
encoding error

The hardware is unable to encode 
the input signal.

Critical, reporting

Unsupported 
audio source

Critical, reporting

Data rate overload The compressed data rate is too 
high.

Increase the compression or 
reduce the required bit rate.

Critical, reporting

Network overload The network is dropping too 
many packets.

Warning, reporting
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Alarm Type Description — Decoder

Alarm Type Description Action Default Settings

No decoder video 
data

Indicates that there is a valid  
connection, no video data  
present. Usually accompanied by 
"no source data stream" message 
in the web interface.

Warning, reporting

No decoder mode No matching decoder mode for 
the incoming stream.

Warning, reporting

No source report Unable to detect the format of the 
received data stream.

Warning, reporting

Recovered audio Warning, reporting

No decoder audio 
data

Warning, reporting

Bad audio at decoder Warning, reporting

Bad audio PLL Warning, reporting

Video network  
packets dropped

Excessive network packet loss 
has occurred.

Warning, reporting

Decoder buffer  
overflow

The incoming data rate is high; 
reduce the pipeline delay. 

Warning, reporting

Decoder buffer  
underflow

The incoming data rate is too low; 
increase the pipeline delay.

Warning, reporting

Bad video PLL The decoder cannot synchronize 
to the video data.

Warning, reporting

No decoder ANC 
data

The decoder is not receiving any 
embedded audio (ancillary) data.

Warning, reporting

Missing ANC at  
decoder

The Decoder is receiving poor 
quality ANC data.

Warning, reporting

Recovered ANC Error correction has recovered  
corrupted / missing ANC.

Warning, reporting

No genlock source 
present

Indicates that genlock is enabled, 
but that there is no genlock 
source connected.

Connect a valid genlock 
signal.

Warning, reporting

No genlock source 
lock

Indicates that a signal is present 
on the genlock connector, but it is 
not within the expected range.

Check the format of the 
genlock signal.

Warning, reporting

Genlock source  
mismatch

Indicates that the timing of the 
genlock signal does not match 
the format of the decoded 
source.

Connect a valid genlock 
signal.

Warning, reporting
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Alarm Type Description — System Controller

Alarm Type Description Action Default Settings

Bad device The controller is unable to contact 
the specified device. The device is 
not available or has failed.
Note that this alarm is only 
generated on the controller.

Check the device in question.
Is power applied?
Is the network cable or 
network connection present?
Has the unit been removed?

Critical, reporting
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Firmware Updates

NOTE:	 The Update page on the web-based user interface is unable to update the 
firmware of the VNM Recorder directly. Use the procedure detailed in this section to 
update the firmware.

This section provides information on:

•	 Preparing the Firmware

•	 Gathering Firmware Installation Information

•	 Installing the Firmware

Preparing the Firmware
Use the following procedure to prepare the firmware for installation.

NOTE:	 For device connection information, see Front Panel Features on page 8 and 
Rear Panel Features on page 10.

1.	 Connect a mouse, a keyboard, and a computer monitor to the VNM recorder.

2.	 Plug a standard IEC power cord into the rear panel of the VNM Recorder and connect it 
to a power source.

3.	 Login into the VNM Recorder using the Red Hat Enterprise Linux login page. Use the 
following login information.

•	 Guest username — matrix_rec

•	 Guest password — matrix

4.	 Call the Extron S3 Sales and Technical Support Hotline and ask for an Applications 
Engineer to supply an updated firmware package file.

NOTES:

•	 The Applications Engineer will provide a download link to the firmware package 
file.

•	 The firmware package file contains tar.gz at the end of the filename.

•	 The firmware package file contains the version number of the file in the filename 
(for example, VNRecorder_ver3.10.9.tar.gz).

5.	 Using a PC connected to the Internet, navigate to the provided download link and save 
the firmware package file to a USB drive.

6.	 Plug the USB drive into one of the USB ports on the VNM Recorder.

7.	 From the desktop of the VNM Recorder, double-click on Computer > Filesystem >  
home > matrix_rec.

8.	 Copy the firmware package file from the USB drive to the above location.
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9.	 From the matrix_rec window, right-click on the firmware package file and select the 
Extract Here option.

NOTE:	 The firmware files are extracted to a subdirectory that is automatically 
named according to the package file, e.g. VNRecorder_verx.xx.x (where x 
represents the version number). The directory path can be changed by renaming 
the folder after extraction has been completed (optional).

Gathering Firmware Installation Information
It is important to gather the current manufacturing and license details before installing new 
firmware onto the VNM Recorder. The config.xml and the admin.xml files are used for 
reference when installing firmware. To access these files, use the following procedure.

1.	 From the VNM Recorder desktop, double-click on Computer > Filesystem >  
home > matrix_rec.

2.	 Double-click on the folder that contains that latest release of the recorder software  
(at the time this guide was released, the latest software would be stored in the 3.10.9 
folder or in a folder with a similar name).

3.	 Right-click on the config.xml file and select the Open with "Emacs Text Editor" 
option. A text window appears containing information needed to complete the firmware 
installation. This text window should be kept open or printed out for reference.

4.	 Repeat steps 1 through 3 for the admin.xml file.
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Figure 36 shows example config.xml and admin.xml files. The text in bold and underlined 
represents important information that will be needed during firmware installation.

	

Figure 36.	 Config.xml and Admin.xml Text Files

Installing the Firmware
Use the following procedure to install the firmware onto the VNM Recorder.

1.	 From the menu bar of the VNM Recorder desktop, select Applications > 
Accessories > Terminal.

2.	 Change to super user mode by typing in the following command and pressing the 
<Enter> key.

•	 su

3.	 When prompted for a password, type in the following and press the <Enter> key.
•	 Extron2010

4.	 Change the directory of the terminal window by typing in the cd command followed by 
the location of the extracted firmware (see Preparing the Firmware on page 58). Then 
press the <Enter> key.

•	 For example:  cd /home/matrix_rec/3.10.9

NOTE:	 This folder name is only an example to illustrate how to write the 
command line. After typing in the cd command, you must enter the correct 
folder location for your extracted firmware (see Preparing the Firmware - 
Step 9 on page 59).
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5.	 Run the installation program by typing in the following command and pressing the 
<Enter> key.
./vnrecorder_install

6.	 A series of prompts will start to request configuration information. Use the  
config.xml and the admin.xml files (see Gathering Firmware Installation 
Information on page 59) while using the Firmware Installation Table below to fill in 
the requested configuration information.

NOTES:

•	 The Controller options and Controller checksum prompts require an 
options key and a checksum which is provided by Extron.

•	 If keys have been previously provided by Extron, they can be found within the 
admin.xml file. See Controller options: and Controller checksum: in 
the Firmware Installation Table below.

Firmware Installation Table

Prompt Value to Enter Xml File 
Reference

Value 
Reference

User name to run 
application:

•	 matrix_rec none none

Serial number: •	 Serial number of the VNM Recorder config.xml serial
Licensed Recorder 
channels:

•	 Check the R value (for example,  
R5, P5, mR, mP, mV determines that 5 is the 
necessary value).

•	 5 is the default value.

config.xml structure

Recorder GUI enabled 
(yes/no):

•	 Check the mV value (for example, 
R5, P5, mR, mP, mV).

•	 If mV is present, answer Yes. Otherwise, answer No.

config.xml structure

License checksum: •	 Checksum of the VNM Recorder

•	 Copy and paste the value

config.xml checksum

Controller IP 
address:

•	 The IP address of the device acting as the system 
controller

config.xml st_controlIP

Controller port 
number:

•	 The controller port number

•	 The default value is 5432

config.xml st_controlPort

Local IP address: •	 The IP address of the VNM Recorder config.xml st_localIP0
Controller options: •	 This is the options key provided by Extron for use in 

VNM Recorders acting as the system controller.

•	 If no data is provided or available, leave blank or 
contact the Extron S3 Sales and Technical Support 
Hotline and ask for a structure key.

admin.xml options

Controller checksum: •	 This is the checksum provided by Extron for use in 
VNM Recorders acting as the system controller.

•	 If no data is provided or available, leave blank or 
contact the Extron S3 Sales and Technical Support 
Hotline and ask for a license key.

admin.xml checksum

Control port: •	 The controller port number

•	 The default value is 5432

config.xml st_controlPort
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7.	 The firmware installation is complete when the command prompt is displayed in the 
terminal window. Manually close the terminal window.

NOTE:	 The recording application is a service, which means that no application 
window will open after the installation has completed.

8.	 To finalize the firmware installation, reboot the VNM Recorder by powering down and 
powering up the unit (see VNM Recorder Power Down Procedure on page 15 and 
VNM Recorder Power Up Procedure on page 13).

9.	 When the VNM Recorder has powered back on, it is necessary to set the folder location 
where the recordings are stored (see Update Path on page 33 and Make Directory 
on page 34).
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Browser 
Configuration

This section provides information on configuring the following web browsers:

•	 Microsoft® Internet Explorer® (version 7 or above)

•	 Mozilla® Firefox® (version 1.3 or above)

Microsoft Internet Explorer (version 7 or above)
1.	 Open Internet Explorer and select Tools > Internet Options. The Internet Options 

window appears (see figure 37).

Figure 37.	 Internet Options

2.	 To enable cookies, select the Privacy tab and (if required) adjust the slider control to 
set the required security level. VN-Matrix systems operate correctly when using security 
that does not exceed the Medium High setting.

NOTE:	 Setting the security slider to block all cookies prevents the VN-Matrix web 
interface from operating.
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TIP:	 If a high security level is required, click on the Edit button and allow the  
VN-Matrix web interface to use cookies (see figure 38).

Figure 38.	 Per Site Internet Options

3.	 To enable JavaScript, select the Security tab (see figure 39).

Figure 39.	 Security Options

4.	 Click the Custom Level button. The Security Settings window appears.
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5.	 Scroll down to the Scripting setting and under Active scripting, select Enable  
(see figure 40).

Figure 40.	 Custom Level Security Options

6.	 Click OK on both dialogs to close and save the new settings.
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Mozilla Firefox (version 1.3 or above)
1.	 Open Mozilla Firefox and select Edit > Preferences. The Preferences window 

appears.

2.	 To enable cookies, go to the Privacy & Security category and choose Cookies  
(see figure 41).

Figure 41.	 Cookie Preferences

3.	 Ensure that either the Enable all cookies or Enable cookies for the 
originating web site only option is selected.

4.	 To enable JavaScript, go to the Advanced category and choose Scripts & Plugins 
(see figure 42).

Figure 42.	 Scripts and Plugins Preferences

5.	 Ensure that the Enable JavaScript for Navigator option is selected.

6.	 Click OK to close the window and save the settings.

 

VNM Recorder • Browser Configuration 66



Mounting

This section outlines the various mounting options available for the VNM Recorder.

•	 Tower Installation

•	 Rack Installation

Tower Installation
Attach the appropriate feet to the unit and place it in a well ventilated area. The tower can 
be placed on its side (horizontally) on a hard surface with the cover latch facing up or placed 
standing up (vertically) on a flat surface.

Rack Installation
This section provides information on installing the recorder into a rack cabinet. Rack 
installation requires the use of the rack mount kit, which is included with the VNM Recorder.

There are a variety of rack cabinets on the market, which may mean the assembly 
procedure will differ slightly. If necessary, refer to the instructions that came with the rack 
cabinet to complete the rack installation.

UL Guidelines for Rack Mounting
The following Underwriters Laboratories (UL) guidelines are relevant to the safe installation of 
these products in a rack:

1.	 Elevated operating ambient temperature — If the unit is installed in a closed or 
multi-unit rack assembly, the operating ambient temperature of the rack environment 
may be greater than room ambient temperature. Therefore, install the equipment in 
an environment compatible with the maximum ambient temperature (TMA: +122 °F, 
+50 °C) specified by Extron.

2.	 Reduced air flow — Install the equipment in the rack so that the equipment gets 
adequate air flow for safe operation.

3.	 Mechanical loading — Mount the equipment in the rack so that uneven mechanical 
loading does not create a hazardous condition.

4.	 Circuit overloading — Connect the equipment to the supply circuit and consider the 
effect that circuit overloading might have on overcurrent protection and supply wiring.  
Consider the equipment nameplate ratings when addressing this concern.

5.	 Reliable earthing (grounding) — Maintain reliable grounding of rack-mounted 
equipment.  Pay particular attention to supply connections other than direct 
connections to the branch circuit (such as the use of power strips).
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Rack Mounting
The supplied rack mount kit includes two rack rail assemblies. Each of these assemblies 
consist of three sections: an inner fixed rail that secures to the recorder frame, an outer rack 
rail that secures directly to the rack itself, and two rail brackets that also attach to the rack 
(see figure 43).

Inner rail

Outer rail

Rail brackets

Figure 43.	 Identifying the Sections of the Rack Rails

To install the recorder into a rack, follow the steps below.

1.	 Remove the inner rail by pulling it out as far as possible. The locking tab should lock the 
rail and make a clicking noise when fully extended. Depress the locking tab to pull the 
inner rail completely out. Do this for both assemblies (one for each side).

NOTE:	 The rails have a locking tab, which serves two functions. The first is to lock 
the recorder in place when installed and pushed fully into the rack. Secondly, these 
tabs lock the recorder in place when fully extended from the rack to prevent pulling 
the recorder completely out of the rack.

2.	 Place the recorder on its side (horizontally) on a hard surface with the cover latch  
facing up.

3.	 Remove the top and right covers by first removing the screws that secure them to the 
frame. Depress the button on the top of the frame to release and remove the cover. 
Remove the screws from the feet and remove them from the frame (see figure 44).

Top Cover

Feet (4)

Figure 44.	 Preparing to Install the Rails
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4.	 Attach the rack handles to the inner rails. 

5.	 Align each inner rail (with the rack handle attached) to the screw holes located on the 
left and right side of the recorder. Secure the rails to the sides of the recorder frame  
(see figure 45). 

NOTE:	 The two inner rail assemblies are left and right specific.

Figure 45.	 Installing the Rails onto the Recorder Frame

6.	 Determine where the recorder will be located within the rack (see the  
UL Guidelines for Rack Mounting on page 67 for safe rack installation). 

7.	 Position the rail brackets at the desired location in the rack. Screw the rail brackets 
securely to the rack. Attach the remaining rail brackets to the other side of the rack, 
making sure both sets are at the exact same height.

NOTE:	 The smaller rail bracket should be positioned at the front of the rack and the 
larger rail bracket should be positioned at the back of the rack.

8.	 Secure the outer rails to the rail brackets.

NOTE:	 The two outer rails are left and right specific.

9.	 Line up the inner rails on the recorder with the outer rails on the rack. Gently slide the 
recorder into the outer rails of the rack (see figure 46). Depress the locking tabs, if 
necessary, when sliding the recorder into the outer rails.

10.	Connect the necessary devices to the recorder (see the Front Panel Features section 
on page 8 and the Rear Panel Features section on page 10).

11.	When the recorder is pushed completely into the rack, the locking tabs make a clicking 
noise. If necessary, secure the rack handles to the rack to keep the recorder in a fixed 
position.
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Rail Brackets

Figure 46.	 Installing the VNM Recorder into a Rack
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gcode Frame 
Translator Utility 
Instructions

The VN-Recorder Frame Translator utility described in this section allows the conversion 
of existing VN-Matrix video recordings to individual still frames. These frames can be 
assembled into standard video, HD video, or other types of media files using third-party 
editing applications.

The utility also allows audio files to be converted to .WAV format.

NOTE:	 The information in this document is accurate for 5-channel VNM recorders 
running firmware version 5.2.0 or later.

This section provides information on:

•	 Overview

•	 Preparation for Using the gcode Frame Translator Utility

•	 Description of the Frame Translator Utility

•	 Recording File Directory Nomenclature

•	 Frame Translation Procedure

•	 Example Strings

•	 Advanced Use

•	 Working with Video and Audio Streams

Overview
To create a media file from a VN-Matrix recording:

1.	 Use VN-Matrix encoders and recorders to create a VN-Matrix recording.

2.	 Create a directory on the VN-Matrix recorder, where the still frames and audio file will be 
stored (see Recording File Directory Nomenclature on page 75).

3.	 Use the Frame Translator Utility to export the video recordings as still frames to the 
directory created in step 2. If required, use the utility to export audio recordings as WAV 
files to the same directory (see Frame Translation Procedure on page 76).

4.	 Transfer the still frames and audio files to a PC running a third-party editing application.

5.	 Create a video or media file from the still frames and audio file.

The main focus of this document is step 3, the Frame Translation Procedure.
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Preparation for Using the gcode Frame Translator Utility
The gcode utility is run in a command window on the recorder where the required recording 
is stored.

A command window may be opened from a remote Windows PC using WinSCP. 

Using WinSCP and PuTTY
1.	 Open WinSCP and enter the IP address of the VN-Recorder. Use the following 

parameters to log in.

•	 Port number = 22

•	 File protocol = SFTP

•	 User_name = matrix_rec

•	 Password = matrix
WinSCP Login ?? XX

Session
Stored sessions

Environment
Directories

SSH

Session
Port number:Host name:

User name:

Private key file:

Password:

10.100.247.87

matrix_rec

22

Protocol
File protocol: SFTP Allow SCP fallback

Advanced op�ons

Select color

CloseSave...Login

Figure 47.	 WinSCP Login

2.	 Select Login. The directory structure of the VN Recorder is displayed:

111

222

Figure 48.	 VN Recorder Directory Structure

By default, recordings are held in the Recording_Files directory (see figure 50, 1) 
and the gcode Utility is located in the VNRecorder_verx.y.z directory (2). Usually, 
only one VNRecorder directory will be present; if the recorder has been upgraded, use 
the current version directory.

 

VNM Recorder • gcode Frame Translator Utility Instructions 72



Opening a command line window
1.	 Use PuTTY to open a command window session from WinSCP. From the Commands 

menu, select Open in PuTTY (see figure 49, 1).

111

Figure 49.	 Open a Command Window Session

A command line window opens with a password prompt:

Using username "matrix_rec".
matrix_rec@10.100.247.87's password:

Figure 50.	 PuTTY Password Prompt

2.	 Enter matrix and press <Return>.

The command line window opens at the following directory location:

/home/matrix_rec

Use the command line window to enter the gcode commands that are described in the 
following section.
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Description of the Frame Translator Utility
The Frame Translator utility is a command line utility that is run from a terminal window 
on the VN-Matrix Recorder. The command line follows this structure:

./gcode command flags

The available command flags are:

Flag Description

-g Enables graphical output. Opens a window that displays each frame in succession after it has 
been exported.

NOTE:	 A local display must be connected to the VN Recorder.

-t Enables targa file output (.tga), one file per frame. Each frame is labelled video and numbered 
sequentially from 1 onwards (for example video000001.tga).

-j quality Enables jpeg file output (.jpg), one file per frame. The quality parameter is a value between 0 and 
100 that sets the compression of the jpg file from the minimum quality value (0, or maximum 
compression) to the maximum quality value (100, or minimum compression). A value of 100 
produces the best quality image with the largest file size. A typical quality value is 80.

-o outputdir outputdir defines the path to the directory where the output files are stored. If this flag is not 
specified, the files are output to the same directory as the gcode utility (typically /home/matrix_
rec/VNRecorder_verx.y.z).

NOTE:	 The -o flag does not create the directory. To create a directory, see step 1 of Frame 
Translation Procedure on page 76.

Each frame is labelled video and numbered sequentially from 1 onwards (for example  
video000001.tga). To aid identification and help with file management, Extron recommends 
that a new output directory is created for each gcode file conversion.

-i inputdir inputdir defines the path to the source directory containing the recording (*.rec) that is being 
exported. For information about selecting the correct directory name, see Recording File 
Directory Nomenclature on the following page.

-l Lists the start and end times for the specified recording. This flag is used in conjunction with the 
-i flag, which specifies the directory where the recorded files are stored. 

-s start time Specifies the time stamp from which the gcode process starts. The time is in the format 
HH:MM:SS.tt.

-f end time Specifies the time stamp at which the gcode process ends. The time is in the format  
HH:MM:SS.tt.

NOTE:	 Setting a start time is optional. It is recommended that an end time is always 
specified. Failure to do this may cause the command window to freeze after the last frame 
to process. If this happens, use the <Ctrl>+<C> keys to end the process.

-h Print help screen. This displays a list of flags and a brief description in the terminal window.

NOTES:

•	 When using the -j, -i, -o, -s, and -f flags, it is necessary to leave a space between the command flag and 
the parameter that follows (for example: -o /home/matrix_rec/Recording_Files/recording1).

•	 Only one stream can be exported at a time. Video and audio must be exported separately (see Working 
with Video and Audio Streams on page 79).

 

VNM Recorder • gcode Frame Translator Utility Instructions 74



Recording File Directory Nomenclature
The -i flag must be followed by the directory path that contains the recording that is being 
exported.

A typical path may look like:

/home/matrix_rec/Recording_Files/Mission1/OTW_5400036.0.0_r0_s0.rec

where:

/home/matrix_rec/Recording_Files/ is the factory default path, where recording files 
are stored.

Mission1/ is a user-created subdirectory for housing a recording session. This session may 
contain recordings from multiple VN‑Matrix recorders.

OTW_5400036.0.0_r0_s0.rec is the directory that holds the recording files for a single 
encoded stream, recorded from one VN‑Matrix encoder. The name reflects whether the 
folder holds a recorded video, audio, data, or whiteboard stream. The individual naming 
elements have the following significance:

Naming element Explanation

OTW Refers to the name assigned to the VN-Matrix encoder at the time of the recording.

_5400036 Refers to the serial number of the VN-Matrix encoder.

.0 This digit refers to the type of recorded content. The options are:
•	 0 — video

•	 A0 — audio

•	 D0 — data

•	 W0 — whiteboard.

.0 Indicates the stream type:
•	 0 — RTP stream

•	 1 — TCP stream

_r0 Indicates the recording channel:

Video Streams
•	 r0 — video recording channel 1

•	 r6 — video recording channel 2

•	 r12 — video recording channel 3

•	 r18 — video recording channel 4

•	 r24 — video recording channel 5

Audio Streams
•	 r1 — audio recording channel 1

•	 r7 — audio recording channel 2

•	 r13 — audio recording channel 3

•	 r19 — audio recording channel 4

•	 r25 — audio recording channel 5

_s0 Indicates the recording number. This value increases incrementally if a subsequent 
recording with the same name is made.
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Frame Translation Procedure
Use the Frame Translation procedure as follows:

1.	 Create an output directory.

To create a new directory on the VN-Matrix Recorder:

a.	 Return to the WinSCP window.

b.	 Use the mouse to select the window showing the VN Matrix Recorder folders.

c.	 Navigate to the required location. Use the <F7> key to launch the Create folder 
dialog.

d.	 Enter the name of the folder and click OK in the dialog box.

2.	 Navigate to the directory holding the Frame Translator utility.

The gcode frame translator utility may be found in the same directory as the VN-Matrix 
recorder application at the following location:

/home/matrix_rec/VNRecorder_verx.y.z

where verx.y.z denotes the version number of the VN-Matrix application files. This 
name may vary slightly depending on which version is installed.

In the Command line window, navigate to the directory containing the Frame Translator 
utility, using the following commands:

cd — change directory

cd .. — go one directory back up the file hierarchy

ls – list the directories and file at the current location

pwd — show the working directory (your current location).

Using username "matrix_rec".
matrix_rec@10.100.245.87's password:
Last login: Wed Feb 12 09:26:11 2014 from 10.100.247.143
[matrix_rec@localhost ~]$ ls
Recording_Files  VNRecorder_ver9.2.2
[matrix_rec@localhost ~]$ cd VNRecorder_ver9.2.2/
[matrix_rec@localhost  VNRecorder_ver9.2.2]$

Figure 51.	 Navigating to the Frame Translator Utility Directory

3.	 Configure the gcode command line in the terminal window.

Once you are in the correct directory, the command ./gcode runs the application 
although, on its own, it won’t do anything until it is told which file to work with. Decide 
which command line flags are needed and type the command line in the terminal 
window. For example:

./gcode -t -o /home/matrix_rec/Recording_Files/Video_Audio_
Data/TGA -i /home/matrix_rec/Recording_Files/Video_Audio_Data/
Chan1_1021526.0.0_r0_s0.rec -s 09:44:18.00 -f 09:44:20.00

NOTE:	 To run the utility, gcode must be preceded by the ./ characters.
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4.	 Press <Enter> to run the command. If an error is detected in the command line, an 
indicator message appears in the terminal window. 

If the command line is valid, the utility exports one image file per video frame to the 
designated output directory. The command line window will continually update as the 
process runs.

If you activate the graphic output flag (-g) for video exports, each frame appears on the 
screen as it is generated.

When the process is complete the command line prompt will be displayed:

SdBase: final close on dbase: 0x933c19c
ntpStart=3581405058 ntpFinish=3581405060
seekToTime: fn= isopen=0
TBPLDLEN=16300
openNewFile(/home/matrix_rec/Recording_Files/Video_Audio_Data/Chan1_1021526.0.0_
r0_s0.rec/device1021526.videoPort0.1021526.0.0_1.rtp)
  rtpts = 3001955953 ntpmsw = 3581405058 ntplsw = 1860627077 payloadtype = 81
mtStart = -1293050332
star�ng at fn=17 (1-->378)
skipped 1 at start of file
syncFrameno to 18
Video Stream: w=1280 h=720
BBB: alloc
ofmt: w:0 h:0 f:0
nfmt: w:1280 h:720 f:60
d�me = 1499.97 fps = 60.000970
TIME: 12420
Timed end of content detected, mt:300298353 fin:-1292870332
Missing Packet, last=0 now=0
StreamExhausted
BBB: free
SdBase: final close on dbase:0x933c19c
SdBase: final close on dbase:0x933946c
[matrix_rec@localhost VNRecorder_ver9.2.2]$

Figure 52.	 gcode Process Completed

NOTES:

•	 The average conversion time for a video file is approximately eight times the 
length of the original recording. One second of recorder content may produce 
60 exported image files.

•	 The conversion time for a audio recording is much shorter. An audio file that 
is 2 minutes and 30 seconds in length is encoded to a .WAV file in less than 
10 seconds.

Example Strings

NOTE:	 The following examples are all unbroken character strings without a line break. 
When the text moves to the next line, it is “text wrap.”

Example1 — decoding a file on the local graphics output
The command is:

./gcode -g  -i /home/matrix_rec/Storage/SAC_Test/
Dave_Gilmour_Dimming_of_the_Day_620027.0.0_r0_s0.rec

•	 Each frame is displayed as it is generated (-g)

•	 No output directory is specified. By default the newly generated files are displayed on 
the local display of the VN Recorder. 

•	 The input directory is /home/matrix_rec/Storage/SAC_Test/Dave_Gilmour_
Dimming_of_the_Day_620027.0.0_r0_s0.rec
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Example 2 — decoding a file to Targa files and placing them in a specified 
output directory

The command is:

./gcode -t -o /home/matrix_rec/Targa -i /home/matrix_rec/Storage/SAC_
Test/ Dave_Gilmour_Dimming_of_the_Day_620027.0.0_r0_s0.rec

•	 Since there is no -g flag, the frames are not displayed as they are generated.

•	 The output is targa (tga) files (-t).

•	 The ouput directory path is /home/matrix_rec/Targa.

Example 3 — outputting JPG files with graphical output
The command is:

./gcode -g -j 80 -i /home/matrix_rec/Storage/SAC_Test/
Dave_Gilmour_Dimming_of_the_Day_620027.0.0_r0_s0.rec

•	 Each frame is displayed as it is generated (-g).

•	 The output is jpg files (-j).

•	 Since no -o flag is set, the output files are stored at the default location (/home/
matrix_rec/VNRecorder_verx.y.z).

•	 The quality setting is 80%.

Example 4 — generating audio files, specifying the output directory.
 To convert an Audio file to a .wav file and place in a folder “Targa.” The default name for the 
audio file is music.wav.

./gcode  -o /home/matrix_rec/Targa -i /home/matrix_rec/Storage/SAC_Test/ 
Dave_Gilmour_Dimming_of_the_Day_620027.A0.0_r1_s0.rec

•	 The gcode utility recognizes that the file is an audio file (.AO) and automatically creates a 
.WAV file with the name music.wav.

Advanced Use

Example 1 — stopping the export process
To stop the export process, press <Ctrl> + <C> at any time. Any image files that were 
generated prior to the process being stopped remain in the specified output folder.

Example 2 — determining the start and end points of the recording
The command is:

./gcode -l -i /home/matrix_rec/Storage/SAC_Test/
Dave_Gilmour_Dimming_of_the_Day_620027.0.0_r0_s0.rec

•	 The -l flag causes the utility to return the start and end time stamp of the recording: 
17:45:27.53 - 17:47:27.65.

•	 The length of the recording is calculated by subtracting the start time from the finish 
time (in this case 2 minutes 0.12 seconds).

 

VNM Recorder • gcode Frame Translator Utility Instructions 78



Example 3 — start decoding a file at a time other than the beginning of the 
recording

The command is:

./gcode -g -s 17:45:37.53 -i /home/matrix_rec/Storage/SAC_Test/ 
Dave_Gilmour_Dimming_of_the_Day_620027.0.0_r0_s0.rec

•	 The file conversion starts ten seconds into the recording at 17:45:37.53.

Example 4 — finish decoding a file at a time other than the end of the 
recording

The command is:

./gcode -g -f 17:46:27.53 -i /home/matrix_rec/Storage/SAC_Test/ 
Dave_Gilmour_Dimming_of_the_Day_620027.0.0_r0_s0.rec

•	 The file conversion finishes at 17:46:27.53.

Example 5 — generating Targa files, specifying the output directory, and the 
start and finish times.

The command is:

./gcode -t -o /home/matrix_rec/Targa -s 17:45:37.53 
-f 17:46:27.53 -i /home/matrix_rec/Storage/SAC_Test/
Dave_Gilmour_Dimming_of_the_Day_620027.0.0_r0_s0.rec

•	 The output files are Targa (tga) files (-t)

•	 The output folder is /home/matrix_rec/Targa

•	 The file conversion starts at 17:45:37.53.

•	 The finish time is 17:46:27.53.

Working with Video and Audio Streams
When recording video content along with associated audio, the Start and Finish times 
for the each of the different recorded file types can differ by a small amount. Usually, the 
video file will be slightly longer and its start and end times will overlap the other files in the 
recording.

The times specified in the gcode utility must take this difference into account or 
synchronization of the content in the converted files will be lost, most noticeable in loss of lip 
sync between video and audio content. 

When using the gcode utility to convert two files, the start and end times set for each file 
conversion must be the same and must overlap.

When setting the start time for a conversion, check the start times for each of the files that 
are to be converted and use the start time of the file that is last to start up, that is the latest 
start time. 

For the end time, use a similar process but use the end time of the file that is first to stop, 
that is the earliest end time.
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Example 1:
VideoStartTime=17:43:13.84				    Video Finish Time = 17:49:11.36

Video file

Audio Start Time = 17:45:35.41				    Audio Finish Time = 17:49:11.20

Audio file

In the above diagram, the start and end times of the video and audio files are different.

NOTE:	 The difference in start time is exaggerated to illustrate this point. In practice, the 
difference will be much smaller.

To create the correct number of video frames and a .WVA file of the correct length you must 
specify the correct Start and Finish times within the gcode command line. 

For this example a Start time of 17:45:35.50 (after both the audio and video files have 
started) and a Finish time of 17:49:11.00 (before either file finishes) would be appropriate.

This results in video and audio files of the same length being created. These files can be 
used with third-party video editing software to produce a correctly lip-synced file.

You will need two separate commands, the first to generate the video file and the second to 
generate the audio file:

./gcode -t -o /home/matrix_rec/Targa -s 17:45:35.50 
-f 17:49:11.00 -i /home/matrix_rec/Storage/SAC_Test/
Dave_Gilmour_Dimming_of_the_Day_620027.0.0_r0_s0.rec

./gcode -o /home/matrix_rec/Targa -s 17:45:35.50 -f 17:49:11.00 -i /
home/matrix_rec/Storage/SAC_Test/Dave_Gilmour_Dimming_of_the_Day_620027.
A0.0_r0_s0.rec

•	 The first command uses a video file to produce targa files (-t).

•	 The second command uses an audio file (.A0) to produce a WAV file.

•	 Both the audio and video files are generated from the same start time (17:45:35.50) to 
the same finish time (17:49:11.00). 
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Worldwide Headquarters:  Extron USA West, 1025 E. Ball Road, Anaheim, CA 92805, 800.633.9876

Extron Warranty

Extron warrants this product against defects in materials and workmanship for a period of three years from the date 
of purchase. In the event of malfunction during the warranty period attributable directly to faulty workmanship and/
or materials, Extron will, at its option, repair or replace said products or components, to whatever extent it shall 
deem necessary to restore said product to proper operating condition, provided that it is returned within the warranty 
period, with proof of purchase and description of malfunction to:

USA, Canada, South America, 
and Central America: 
Extron 
1230 South Lewis Street 
Anaheim, CA 92805 
U.S.A.

Asia: 
Extron Asia Pte. Ltd. 
135 Joo Seng Road, #04-01 
PM Industrial Bldg. 
Singapore 368363 
Singapore

Japan: 
Extron, Japan 
Kyodo Building, 16 Ichibancho 
Chiyoda-ku, Tokyo 102-0082 
Japan

Europe: 
Extron Europe 
Hanzeboulevard 10 
3825 PH Amersfoort 
The Netherlands

China: 
Extron China 
686 Ronghua Road 
Songjiang District 
Shanghai 201611 
China

Middle East: 
Extron Middle East 
Dubai Airport Free Zone 
F13, PO Box 293666 
Dubai, United Arab Emirates

Africa: 
Extron South Africa 
South Tower
160 Jan Smuts Avenue
Rosebank 2196, South Africa

This Limited Warranty does not apply if the fault has been caused by misuse, improper handling care, electrical 
or mechanical abuse, abnormal operating conditions, or if modifications were made to the product that were not 
authorized by Extron.

NOTE:	 If a product is defective, please call Extron and ask for an Application Engineer to receive an RA (Return 
Authorization) number. This will begin the repair process.

	 USA:		  714.491.1500 or 800.633.9876		  Asia:		  65.6383.4400
	 Europe:	 31.33.453.4040 or 800.3987.6673	 Japan:		  81.3.3511.7655
	 Africa:		  27.11.447.6162				   Middle East:	 971.4.299.1800

Units must be returned insured, with shipping charges prepaid. If not insured, you assume the risk of loss or damage 
during shipment. Returned units must include the serial number and a description of the problem, as well as the 
name of the person to contact in case there are any questions. 

Extron makes no further warranties either expressed or implied with respect to the product and its quality, 
performance, merchantability, or fitness for any particular use. In no event will Extron be liable for direct, indirect, or 
consequential damages resulting from any defect in this product even if Extron has been advised of such damage.

Please note that laws vary from state to state and country to country, and that some provisions of this warranty may 
not apply to you.


